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Chapter 1

Getting Started with PeopleSoft Application
Management Plug-in

Understanding PeopleSoft Application Management Plug-in

The PeopleSoft Application Management Plug-in uses Oracle Enterprise Manager to provide an
integrated, graphical user interface for monitoring and managing components of a PeopleSoft
environment.

The entities that Enterprise Manager monitors and manages are called managed targets, which are
separately manageable and named entities within the enterprise, such as databases, application servers,
Process Scheduler servers, web servers, and so on.

The Oracle Enterprise Manager product includes the Management Agent, Oracle Management Service,
Management Repository Database, and the Cloud Control Console, which is a browser-based central
console through which administrators can perform monitoring, administration, and configuration tasks for
the enterprise.

Common Terms Used in This Book
 Administrator Account Administrator accounts provide users permission to perform

administrative tasks and access administrative information. You
can set up each administrator account to have its own privileges
and notification rules. There are two types of administrator
accounts:

• Super Administrator

• Administrator

 Incidents Indicates a potential problem; either a warning or critical
threshold for a monitored metric has been crossed. An alert can
also be generated for various target availability states. Enterprise
Manager provides various options to respond to Incidents.
 Administrators can be notified automatically when an alert
triggers and can set up corrective actions to resolve an alert
condition automatically.

 Beacon A special target installed on an agent that runs a defined service
test and reports the results to the Oracle Management Service to
determine the status and performance of a service.
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 Dashboard Presents information using intuitive icons and graphics that let
you spot recent changes and quickly identify and respond to
problems.

  Discovery Process The process of identifying and registering targets in Enterprise
Manager so that they can be monitored and managed from the
Enterprise Manager console. Targets are discovered one host at
a time.

 Enterprise Manager Cloud Control
Console

The Oracle Enterprise Manager web-based user interface for
centrally managing the entire PeopleSoft environment. It can be
accessed from a client workstation running a browser that meets
the minimum client requirements of the Enterprise Manager.

 Management Agent A process deployed as binaries on each of the monitored
hosts. It is responsible for monitoring all targets in the host,
 communicating the information to the middle-tier management
service, and managing and maintaining the host and its targets.

 Management Repository This is an Oracle database that contains all the available
information about administrators, targets, and applications
managed within Enterprise Manager. Captured data is uploaded
to the repository through the Oracle Management Service.
 The Repository organizes the data and makes it available
for retrieval—allowing the data to be shared between any
administrators accessing the Cloud Control Console.

Oracle ADF This is a Java EE framework for building enterprise applications
through a visual and declarative development experience.

 Oracle Management Service A web application (J2EE-compliant) that renders the user
interface for the Oracle Enterprise Manager Cloud Control
Console. It works with all management agents to process
monitoring and job information, and uses the Management
Repository as its data store. The Oracle Management Service 
(OMS) runs within the Oracle WebLogic Server layer of the
framework.

 PeopleSoft System A group of targets that are associated with a particular
PeopleSoft application database. Depending upon how many
PeopleSoft applications you have installed, you may have
multiple PeopleSoft Systems to manage.

 PeopleSoft Global Unique Identifier
(GUID)

A unique identifier for each PeopleSoft database. The GUID
ties each target to a specific database and defines all targets
referencing the same database GUID as a system. The GUID is
generated and stored at the database layer. During the discovery
process, the application server connects to the PeopleSoft
application database and retrieves the GUID for that database.
 This value is derived from the PeopleTools PSOPTIONS table.
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Region A region is a visual box with a title that can be expanded and
collapsed. Regions can have charts, tables, label and value pairs,
 Chiclets, standard web widgets, and other UI elements.

 Rules Define the desired behavior or characteristics of systems. By
using preconfigured or custom rules, automated assessments
of systems and applications are performed. Through violation
messages, you are notified of any deviations, such as
inappropriate settings or incorrect system configurations.

 Preferred Credentials Simplify access to managed targets by storing target login
credentials in the Management Repository. With preferred
credentials set, users can access a target that recognizes those
credentials without being prompted to log in to the target's host
machine. Preferred credentials are set on a per user and per
target basis, ensuring the security of the environment.

 Service An entity that models a business process or application.
 Examples of services are HCM applications, online banking,
 and email services. You can define services by creating one or
more service tests that simulate common end-user functions.
 Using these service tests, you can measure the performance and
availability of critical business functions, receive Incidents when
there is a problem, identify common issues, and diagnose causes
of failures.

 System A set of targets (hosts, databases, application servers, and so
on) that function together to host one or more applications or
services.

 Super Administrator Account Can manage all other administrator accounts and set up all
administrator credentials. In addition, the super administrator
can:

• Create privileges and roles.

• Perform the initial setup of Enterprise Manager.

• Add targets to Enterprise Manager.

• Perform actions on targets in the system.

Note: Enterprise Manager is installed with a default super
administrator account named SYSMAN. You use the SYSMAN
account for the initial login to Enterprise Manager. Then, create
new super administrator accounts as needed in your system.

Train The train is a guided workflow or wizard that walks users
through a sequence of steps by stringing together a series of
pages.The objective of these steps is to guide users through the
task of achieving a specific goal.
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 Topology Viewer Enables you to view the relationships between targets within the
context of a system. You can perform some management actions
from this view.

Features of the PeopleSoft Application Management Plug-in
The PeopleSoft Application Management Plug-in:

• Installs into and integrates with the Oracle Enterprise Management System.

• Discovers and registers PeopleSoft targets.

• Monitors and manages PeopleSoft targets, which includes viewing performance metrics and
performing actions such as start, stop, configure, and other specific tasks relevant to each target type.

• Submits and monitors Process Scheduler requests.

• Displays configuration data in a graphical user interface driven by metadata.

This ensures that you enter appropriate values and helps limit potential errors in configuration.

• Provides log management for PeopleSoft targets, including the ability to search, view, export, and
purge log files.

• Creates a PeopleSoft system in Enterprise Manager based on the database.

This enables you to group all the targets in the system related to a PeopleSoft application database.

• Generates a graphical topology that displays the relationships between targets.

• Creates a service that simulates a transaction, such as login and logout, to monitor the availability of
an application.

Using the Enterprise Manager Service Level Monitoring feature, you can also check the availability of
a system or a feature of an application.

The PeopleSoft Application Management Plug—in delivers a login and logout transaction service for
a PeopleSoft system.

• Provides custom Compliance rules to evaluate configuration data for PeopleSoft target types.

Managing User Accounts
Defining user access for the Enterprise Manager and the PeopleSoft targets is important and should be
considered prior to installing the PeopleSoft AMP to ensure you are aware of all the implications of the
options. The options for managing the user accounts you use for installing, configuring, and implementing
the PeopleSoft AMP are discussed in detail in the installation instructions.

See Also

Installation Guide: PeopleSoft Application Management Plug-in 13.3.1.1.0 for Oracle Enterprise Manager
13c.

12  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 1 Getting Started with PeopleSoft Application Management Plug-in

PeopleSoft Application Management Plug-in Installation
You install the PeopleSoft Application Management Plug-in after you have installed the Oracle Enterprise
Manager software and PeopleTools.

For detailed information about Enterprise Manager features, benefits, documentation, and downloads
refer to the Oracle Enterprise Manager 13c overview page on the Oracle Technology Network.

For information related to the version of Oracle Enterprise Manager Cloud Control software that is
required for the PeopleSoft Enterprise Manager Plug-in, see the PeopleSoft certification information
posted on My Oracle Support.

See, Oracle Enterprise Manager Cloud Control Documentation 13c Release 1

PeopleSoft Target Discovery
After you have installed all of the required software, you can begin the discovery of the PeopleSoft
targets. PeopleSoft targets refer to the elements of a PeopleSoft environment, such as an application
server, application database, PeopleSoft website, and so on.

The discovery process identifies and registers PeopleSoft targets in Enterprise Manager so that they can
be monitored and managed.

Discovery is the process of searching for and registering PeopleSoft targets so that Enterprise Manager
can monitor and manage them. It is the first step to be performed after you have installed all of the
required software.

During this process, you use a series of Enterprise Manager screens to:

• Select the target types to be discovered.

• Enter credentials so that Enterprise Manager has access to the host where discovery is to be
performed.

• Register the discovered targets in Enterprise Manager.

• Enter the information required to connect to the PROCESSREQUEST web service.

• Identify and register the Process Monitor target.

• Set environment variables needed to connect to the PeopleSoft application database.

• Identify and register the associated application database.

• Review the registered targets.

Understanding PeopleSoft Target Types

After the PeopleSoft targets have been discovered you can begin monitoring and managing PeopleSoft
systems and targets. Concepts and tasks relating to systems and targets are discussed in individual
chapters devoted to each target type.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved. 13
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PeopleSoft Target Types
The following PeopleSoft specific target types allow monitoring and management of a PeopleSoft
environment:

 PS Application Database (PS App
DB)

Refers to the PeopleSoft application database running the
application, such as CRM or HCM. There can only be one
PeopleSoft application for each installed application database.

 PS Application Server Domain Key target type of a PeopleSoft environment. It does all of the
complex logic and computations and builds the contents that the
web server uses to display pages.

 PS Process Scheduler Domain Enables batch job scheduling and processing.

 PS Process Monitor Enables you to monitor and submit processes configured to run
on a Process Scheduler server.

 PS PIA Allows Enterprise Manager to manage the PIA component.
 It corresponds to a Web domain in Weblogic, server in
WebSphere.This target type contains one or more PS Web Site
targets.

 PS Web Site Comprises the specific web application and its corresponding
HTML files, image files and resource files. It also includes
configurations and page content. PS Web Site targets always
belong to a PS PIA target.

 PS Search Server Domain Refers to a remote server running Verity search requests for one
or more application server domains.
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Understanding PeopleSoft Application
Management Plug-in Pages

Understanding PeopleSoft Application Management Plug-in
Pages

This section discusses:

• The Enterprise Manager homepage.

• The All PeopleSoft Targets homepage.

• The common elements used on the PeopleSoft target domain pages.

Understanding the Enterprise Manager Homepage
The Enterprise Manager homepage gives you a high-level view of the overall status of all the targets
being monitored. It summarizes key information, such as availability across all managed targets, open
alerts, rule violations, and recent problems with job executions. Links on this page enable you to drill
down to access detailed performance information.

The homepage is the first page that appears when you log on to Enterprise Manager.

Image: Oracle Enterprise Manager Homepage

This example illustrates the fields and controls on the Oracle Enterprise Manager Homepage.
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Understanding the All PeopleSoft Targets Homepage

The All PeopleSoft Targets page lists and displays the summary of all the PeopleSoft targets discovered
and registered in Enterprise Manager. You can filter the view so that only specific target types are shown.

Access the All PeopleSoft Targets page to create, discover, organize, access, search, and monitor
PeopleSoft targets ( Targets >PeopleSoft ).

Note: The target types that are displayed depend on the access rights or privileges that have been set for
the user.

Image: All PeopleSoft Targets page

This example illustrates the fields and controls on the All PeopleSoft Targets page. You can find
definitions for the fields and controls later on this page.

 
Click this to show the most current status of the targets. .

 Search Select a target type to search for a specify target.

For example, to search for only application server domains,
 select PS Application Server Domain from the Search list and
then click Go.

 View Select a view type to determine how the PeopleSoft targets will
be grouped.

For more information about viewing target types, see Viewing
PeopleSoft Targets on the All PeopleSoft Targets Page.

 Create Use this to create an application server, process scheduler
server, search server domain, and PIA domain from the
Enterprise Manager Console.

The commands that is submitted from the Enterprise Manager
are handled by an API layer that captures the commands and
submits the appropriate, native, command line options on the
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host for the server type. For example, submitting the "configure
domain" option in Enterprise Manager runs the following
PSADMIN command:

psadmin -c configure -d domain

For more information about creating PS Application Server
targets, see Creating PeopleSoft Application Server Domain
Targets.

 Logical Grouping Click this to view the PeopleSoft targets by:

• Logical Group By Apps: Displays the PeopleSoft targets
according to the logical groups. Each target appears within
an expandable node hierarchy grouped by PeopleSoft
application or custom category in the order you choose.
 This enables you to easily identify and administer targets
associated with a specific PeopleSoft application, such as
HCM, or associated with a specific category of system, such
as production, test, or demonstration.

See Organizing PeopleSoft Targets.

• Host Based Grouping: Displays the PeopleSoft targets
according to the host on which they run. Each target
appears within an expandable node representing the host.
 For example, if you need to bring down a server host for
maintenance, you can view by host to identify the targets
affected.

Note: PeopleSoft targets not belonging to any logical
group appear under Unlinked Targets. If, for example, a PS
Application Database with child targets is removed from the
environment, the system moves the child targets to Unlinked
Targets to indicate that they are "orphaned."

Note: Just after discovery, PeopleSoft targets may appear
under Unlinked Targets until after a successful configuration
collection.

Actions Click this to start, stop or remove selected PeopleSoft targets.

Add Targets Click this to discover and register all valid PeopleSoft targets of
your host in Enterprise Manager.

See, Adding Targets and Understanding the Discovery Process.

Organize Targets Click this to access the Setup Logical Grouping page, where
you can customize how PeopleSoft targets are grouped and
displayed.

For more information about organizing targets, see Organizing
PeopleSoft Targets.
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Target Name Lists the targets discovered.

Target Type Specify the target types. For more information about target
types, see Understanding PeopleSoft Target Types.

Target Status Specifies whether the target is running or has stopped.

Host Specifies the host URL on which the target is running.

Incidents Displays incidents that are generated. An alert is generated when
a metric threshold value is reached. The most recent alerts are
listed first. By clicking a specific alert message, you can drill
down to explicit details about the metric in the alert.

Compliance Delivers the rules and standards and deviations to system
or application. For example, deviations about inappropriate
settings and incorrect system configuration will be displayed.

Framework Click to displays the industry-specified best practices guideline
that deals with the underlying IT infrastructure, applications,
 business services, processes and how they are organized,
 managed, and monitored.

Standard Click to displays the EM’s representation of a compliance
control that must be tested against some set of IT infrastructure
to determine if the control is being followed.

Incidents Displays incidents that are generated. An alert is generated when
a metric threshold value is reached. The most recent alerts are
listed first. By clicking a specific alert message, you can drill
down to explicit details about the metric in the alert.

Viewing PeopleSoft Targets on the All PeopleSoft Targets Page
On the All PeopleSoft Targets homepage, click the View tab.

Image: All PeopleSoft Targets - View Tab

This example illustrates the fields and controls on the All PeopleSoft Targets page - View list. You can
find the definition of the fields and controls later on this page.

Column Click this to specify the columns on the All PeopleSoft Targets
page. You can choose to show all the columns or display
specific columns, such as, Target Type, Target Status, and Host.
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Expand All Click this to expand the list of targets in the Target Name
column.

Collapse All Click this to collapse the list of targets in the Target Name
column.

Reorder Column Click this to reposition the columns.

On the Reorder Column dialog box, click a column name and
use the arrows to reorder.

Creating PeopleSoft Targets
On the All PeopleSoft Targets homepage, click the Create tab.

Image: All PeopleSoft Targets - Create Tab

This example illustrates the fields and controls on the All PeopleSoft Targets page - Create list. You can
find the definition of the fields and controls later on this page

PS Application Server See Creating PeopleSoft Application Server Domain Targets.

PS Process Scheduler See Creating PS Process Scheduler Domain Targets.

PS PIA See Creating PeopleSoft PIA Domains Target.

PS Search Server See Creating a PS Search Server Domain.

Adding Targets
The first discovery process should be run on a host containing any of the Tuxedo-based domain targets,
which are PS Application Server, PS Process Scheduler, and PS Search Server Domains. The host should
have the same time zone as the PS Application Database to which it's connected, and the same timezone
of most of the other PeopleSoft servers or hosts. During this initial discovery, the system expects that the
PS Application Database will be also be discovered.

The PeopleSoft Application Management Plug—in can monitor only PS Application Databases from
Tuxedo domain targets that are in the same timezone. When the database is registered in Enterprise
Manager, it must be the database of most of the Tuxedo domain targets.

For example, assume you have a PeopleSoft environment with four UNIX servers with PS Application
Server domains in one timezone and one Windows server with a Process Scheduler domain in another
timezone. You should execute the first discovery on one of the four UNIX servers. You should not
execute the discovery first on the Windows server.

Note: You must first set up the preferred credential for the host before starting the discovery.
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To add targets, follow these steps:

1. Select Targets > PeopleSoft. >Add Targets.

Image: Add PeopleSoft Targets : Discovery Inputs page

This example illustrates the fields and controls on the Add PeopleSoft Targets : Discovery Inputs
page. You can find definition for the fields and controls later on this page.

From this page, you can select one or more target types for the discovery process running on a single
host.

 PeopleSoft Target Types All target types are selected by default. The PS_HOME/PS
_CFG_HOME target check box cannot be cleared because
Enterprise Manager must discover it first to establish the
basis of the PeopleSoft system. When the PS_HOME
and PS_CFG_HOME directories are found, the search
continues for any PeopleSoft targets present (for example,
 an application server, web server, Process Scheduler, and so
on).

A PS Web Site cannot be registered without a parent PS
PIA target having been registered in a current or a previous
discovery process.

Note: Beginning with PeopleTools 8.50, with decoupled
PIA_HOMEs and PS_CFG_HOMEs, provide the path to
PS_CFG_HOME or PIA_HOME. If PS_HOME is secure 
(read-only) it may not contain any targets. The discovery
process will discover all the selected targets in the specified
path.

  Host Select the host on which your desired targets run. The
system verifies that you have entered a valid host.

Note: The list of hosts only displays those hosts on
which Enterprise Manager agents have been installed and
registered with the OMS. By default, the system displays all
hosts on which a registered Enterprise Manager agent exists,
 regardless of whether any PeopleSoft elements have been
installed on that host.

  Discovery Path Enter the paths from which the search (crawl) should begin.
 Separate multiple paths with a semicolon.
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The path should include PS_HOME, PS_CFG_HOME, and
PIA_HOME, (as appropriate for your installation). A path
with spaces should be enclosed with double quotes. For
example:

"c:\Program Files(x86)\psft\pt\853"

Note: The discovery path does not support UNC mapping.
 The discovery path should contain only local drives. The
PeopleSoft AMP does support a remote/shared read-only PS
_HOME (with a UNC path) for Windows (on PeopleTools
8.50 or later). PS_CFG_HOME should be a local folder
and provided in the discovery path. If the PS_CFG_HOME
points to a remote PS_HOME (UNC path), PeopleSoft
AMPdiscovers it.

  Crawl Depth Specify the number of nested directories that an agent
crawls during the discovery process. The default is 2.

Crawl depth applies to each directory entered in the
discovery path. For example, if you specify a value of 3 and
have more than one discovery path listed, the agent searches
3 levels in each directory.

2. Click Next. to enter the credentials for the host machine on which you want to run the discovery
process.

You can either choose a preferred or a named credential for the selected host. The credential appearing
on this screen would become the preferred and monitoring credential of the target.

Note: This credential for the host must match the user ID of the user who installed the PeopleTools
environment on the host.

Click Next to view the discovery result on the Add PeopleSoft Targets : Discovery Results page.

3. Select a target and click Next to display the PeopleSoft targets whose databases are discovered.

The Add PeopleSoft Targets : Discover Database page appears showing a list of targets for which
environment variables may need to be set.

4. On the Add PeopleSoft Targets : Discover Database page, specify any required environment variables.
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Image: Discover Database page

This example illustrates the fields and controls on the Add PeopleSoft Targets : Discovery Database
page. You can find definition for the fields and controls later on this page

Select a target and then set the parameters.

  Set Environment Variables Click to configure settings that enable connection to an
application database.

See Setting Environment Variables.

 Target Name Name of the PS Application Server Domain, Process
Scheduler Domain, or PS Search Server Domain that can
have a PS Application Database.

This value displays as a link to the target homepage, which
you can select to open in a new window.

  Target Type The type of target being registered.

  DB Type The type of database to which the target is connecting.

  Environment Set Shows a green check mark when environment variables
have been set for the database (if required for a specific
database type). Shows a red X when environment variables
have not been set.

The environment variables referred to in this field are
database connectivity parameters and vary depending on the
database type.

  Databases Discovered Shows a green check mark when the application database
is successfully discovered which means that Enterprise
Manager can collect configuration data from the target and
collect the PeopleSoft GUID from the application database.

Shows a red X when discovery is unsuccessful. Possible
reasons are:

• The environment variables have not been set correctly.
 Verify them on the Set Environment Variables page.

• The database information is incorrect. Select the target
to open it in a new window. Select the Administration
tab, then Configure Domain to display configuration
data. Validate database information here.
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• The configuration collection has failed. Select the link
for the target in the Name column. The target homepage
appears where you can check for metric collection errors
displayed above the Incidents section.

  Discover Related Databases Click this icon to initiate discovery.

5. Click OK on the Add PeopleSoft Targets : Discovery Summary page.

This registers the targets and the target discovered appears on the All PeopleSoft page.

Note: When the Percentage of Memory Growth parameter in the [PSAPPSRV] section of the application
server domain configuration file (psappsrv.cfg) is uncommented, then the parameter needs to be
uncommented in the corresponding metadata file, psappsrv.cfx, as well. This will ensure successful
discovery of the PS Application Server Domain Target and Application Database Target when this
parameter is uncommented.

Note: For Solaris platforms, to ensure successful discovery, unset LD_LIBRARY_PATH_64 environment
variable. Do this by adding unset LD_LIBRARY_PATH_64 to the .profile or in the psemenv.sh
script accordingly.

Note: For Windows platform, use the same user name as the host to log on. The discovery fails if the user
enters the domain_name\user_name to log into the host.

Setting up Preferred Credential
To set up the preferred credential:

1. Select Setup, Security, Preferred Credentials.

2. Click a host to set the preferred credential.

Working With Target Naming Conventions
Enterprise Manager requires that all discovered targets be assigned a unique name that serves as the
target's key.

Target Type Naming Convention Example

PS Application Database <DBName>+db.+<PeopleSoft GUID> CRMPRD.db.66ce0b93-85bb-11d9-

92af-fa37c30c4526

where

DBName = CRMPRD

GUID = 66ce0b93-85bb-11d9-92af-
fa37c30c4526
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Target Type Naming Convention Example

PS Application Server Domain <domain>+app+<host>+<PS_HOME> CNVCRM.app.server1.usr_local

where

domain = CNVCRM

Host = server1

PS_HOME = /usr/local

PS Process Scheduler Server Domain <domain>+prcs+<host>+<PS_CFG_
HOME>

CNVCRM.prcs.server1.usr_local

PS Search Server Domain <domain>+srch+<host>+<PS_CFG_
HOME>

CNVCRM.srch.server1.usr_local

PS PIA using WebLogic or WebSphere <PIA domain name>+pia+<host>+<PS_
HOME>

peoplesoft.pia.server1.usr_local

where PIA domain name = peoplesoft

PS Web Sites using WebLogic or
WebSphere

<site name.PIA domain name>+site
+<host>+<PS_HOME>

ps.peoplesoft.site.server1.usr_local

where site name = ps

PS Process Monitor prcs-mntr.<protocol>.<host>.<port>.
<wsdl file name>

prcs-mntr.http.pta137.10180.

PROCESSREQUEST_1_wsdl

Additional naming conventions:

• If the host name has the fully qualified DNS name, the name server1.peoplesoft.com becomes
server1.

• A Windows path, for example C:\ptinstall\appserv, becomes c_ptinstall_appserv. Any dots (.) or
colons (:) are removed, and backslashes (\) and spaces are replaced with an underscore (_).

Related Links
Understanding the Discovery Process

Organizing PeopleSoft Targets
Access the Setup Logical Grouping page to customize how PeopleSoft targets are logically grouped and
displayed. (Click the Organize Targets tab.)
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Image: Setup Logical Grouping

This example illustrates the fields and controls on the Setup Logical Grouping page.

 Logical View Enables you to determine how the PeopleSoft targets will be
grouped on the All PeopleSoft Targets page. The selection you
choose determines the value of the View drop-down

• Logical Group by Apps: When selected, the PeopleSoft
targets will be grouped by the App Name value as specified
on this page. That is, they will be grouped first by App
Name and then by Category Name.

• Logical Group by Category: When selected, the PeopleSoft
targets will be grouped by the Category Name value as
specified on this page. That is, they will be grouped first by
Category Name and then by App Name.

Note: After PeopleSoft targets are discovered for the first time,
 Logical Group by Apps is enabled.

 Associate unlinked targets to logical
groups

Select to add any targets currently under the Unlinked Targets
category to your logical groups, based on the unlinked target's
association with an existing database.

 Database Target Displays the database target ID for the database associated with
a system.

 PS System Target Shows the system target ID associated with a specific
PeopleSoft system.

 App Name Enables you to modify display names for PeopleSoft application
targets. By default, the system gathers this information from the
database type, showing PeopleTools, HCM, CRM, and so on.
 If you want to modify this value, use the App Name edit box
to add your custom value. Make sure use a consistent naming
convention.

 Category Name Enables you to modify display names for PeopleSoft application
targets. By default, the assigned category name is PROD (for
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Production), but you may want to add values such as TEST,
 DEMO, and so on. If you want to modify this value, use the
Category Name edit box to add your custom value. Make sure to
use a consistent naming convention.

 Instance Name Defaults to the PS System Target ID value, such as Q852107R.
pssystem.22af5ff2-4af9-11e0-9d38-91c7730a9ea8. If you'd like
to modify this value, use the Instance Name edit box to add your
value. You might consider just using the database name, or some
other shorter value.

 Save You must click Save for any changes, including Logical View
selection to take effect.

Common Elements on Targets Homepages

This section describes the following common elements that appear on PeopleSoft target home pages:

• Monitoring

• Control

• Job Activity

• Information Publisher Reports

• Performance

• Configuration Management

• Domain Management

• Log Management

• Configuration

• Compliance

• Target Setup

• Target Information

Note: Not all elements will appear on every target homepage. For example, some elements appear only
for database targets, while others appear only for Process Scheduler targets.

Monitoring
This table lists the common elements that are available for monitoring targets.

All Metrics Click this to display all of the metrics defined for the target.
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Metrics and Collections Settings Click this to display the metric thresholds and collection interval
for the target.

Metrics Collection Errors Click this to view the details about the errors encountered while
obtaining target metrics. This helps to get the detail of the metric
that do not represent the performance of the target accurately.

Status History Click this to get information about target outages. This
information is essential for troubleshooting target related
incidents.

For more information about status history, see Oracle®
Enterprise Manager Cloud Control Getting Started with Oracle
Fusion Middleware Management Plug-in Release 13.3.1.1.
0, “Discovering and Monitoring Oracle Business Intelligence
Instance and Oracle Essbase”, Viewing Target Status and
Availability History.

Incident Manager Click this to get details about the various events, related to
the PeopleSoft target, that negatively impact any hardware
or software component. These events require user action.
 The details provided by this section, such as the incident
summary, severity, target, target type, and so on, are essential for
troubleshooting.

Alert History Click this to displays a complete alert history of the target.

Blackouts Click this to displays the blackouts that have been defined for
the target history. You can also set up a blackout from this page.

Control
Click this to create or end blackouts.

Blackouts allow Enterprise Manager users to suspend management data collection activity on one or more
managed targets. For example, administrators use blackouts to prevent data collection during scheduled
maintenance or emergency operations. By blacking out the server, alert notifications are not sent.

Job Activity
Access this to search for a particular job and retrieve job details such as the owner, status, scheduled start
time, and so on. From this page, you can perform target job administration tasks, such as creating, editing,
suspending, and resuming a job.

Information Publisher Reports
Access this page to get the summary of the Service Level Agreement Compliance, Actual Service Level
Achieved, Key Performance and Usage Metrics, and Status of Key Components.
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Performance
Access the Performance page from the PeopleSoft application domain list.

The Performance page gives you a snapshot of the performance of the domain by displaying a graphical
view of the domain's:

Note: This is an example from PS Application Server Domain Target.

• Host CPU usage.

• Host memory usage.

• Disk input/output utilization.

• Average number of queued processes per domain server process.

• PSAPPSRV handler counts.

• Total number of Tuxedo connections.

Use the View Data dropdown list to modify the time frame of the display. For example, you can view the
last 24 hours, last week, last month, and so on.

If the PUBSUB (Integration Broker server processes) feature is not active, the graphs for Broker,
Subscriber, and Publisher are blank.

The CPU and memory utilization shown on the PS Application Server Domain Performance page
includes more detailed information than that on the homepage.

The frequency of the disk I/O (read/write frequency) indicates how much the application server is caching
—this value may reflect the performance of the application. It also includes writing to log files.

The amount of queuing on the main processes of a PS Application Server Domain indicates if the defined
handlers are sufficient for the domain. Larger queues cause a slow response on application functions, and
this could indicate that more handlers or domains are required to handle user requests.

Note: A statement of no data found may appear in the graphic region. This occurs because there is no
target data available in Enterprise Manager when this graph is rendered.

For more information about changing the view of performance data, see Enterprise Manager
documentation.

Configuration Management
This table lists the common elements that are available for managing configuration of targets.

Configure Domain Click this to access the Configure Domain page to edit domain
configurations.

See the product documentation for PeopleTools: System and
Server Administration, "Working With Domain Configurations"

28  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 2 Understanding PeopleSoft Application Management Plug-in Pages

• If this domain is up and the Allow dynamic changes
property is selected, only dynamic fields can be edited. All
others are disabled.

• If this domain is down, all fields are enabled.

From the Configure Domain page, you can select Configure
Environment Variables to edit settings that establish the
connection from the domain to the application database.
 Depending on the database type of the domain, there are
required, default environment settings shown for which you
need to provide the appropriate values.

• Configuration details region.

• Move the mouse over the information icon to display a
description of the field.

• If the dynamic icon is present, it means that the field is
dynamic and a restart of the domain is not necessary if
there were changes (and if the Allow dynamic changes
option is set).

• Enable check boxes display for some fields to
accommodate any commented out properties within
the configuration files. If desired, you can enable the
commented out properties by selecting the check box.

See Setting Environment Variables.

Create Like Domain Click this to import a domain from another PS Application
Server Domain or PS Process Scheduler Domain. You can
create a like domain only within the same host referencing the
same PS_HOME.

Copy Configuration Click this to copy configuration files from an existing domain
to another domain within the same host. This overwrites the
configuration files on the managed host.

Note: This feature does not work on domains that are currently
running.

Discover Database Click this to discover the Database associated with this target.
 This menu provides an alternate way to discover the database
target, if they did not get discovered in the main discovery
workflow.

See Understanding the Discovery Process.

Domain Management
This table lists the common elements that are available for domain management of targets.
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Start Domain Click this to start an individual target.

A serial boot starts server processes in a sequential order, with
one process beginning to start after the previous process has
completely started.

Start Domain (Parallel) Click this to start server processes in parallel. This ensures
shorter boot duration.

Stop Domain Click this to shut down the domain and is equivalent to the
normal shutdown option in PSADMIN.

Stop Domain (Forced) Click this to stop an individual target. A forced shutdown is
a non-quiescent shutdown that immediately terminates all of
the processes in the domain. Use forced shutdown only when
a Bulletin Board Liaison (BBL) process encounter errors and
cannot be shut down normally.

Delete Domain Click this to delete the domain on the host and remove it from
Enterprise Manager.

Note: The domain must be down before you can delete.

Log Management Page
Access the Log Management Page to:

• View log files.

• Search for strings in a log file.

• Add and remove log patterns.

Viewing Log File
Image: View Log File page

This example illustrates the fields and controls on the View Log File page. You can find definitions for the
fields and controls later on this page.

If you have searched for a string, you can also click the link by the line number or the string (in the results
area) to display the View Log File page.
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The initial view contains 500 lines and the string is the last one shown. Click Previous, Next, Top, or
Bottom to navigate through the file.

The log filename is also available within the search results area.

 Refresh Click Refresh to refresh the screen.

 Export to file Click Export to File to export the log file. You can open the file
in the Notepad or save the file to your workstation.

Searching for Strings in a Log File
To search for a string in a log file:

1. Click the file you want to search, using the radio button in the Select column.

2. Scroll to the bottom of the Logs page.

3. Enter the desired search string in the Search String edit box.

4. Click Search.

5. In the Search Results Cloud, review the instances of the search string found in the log file.

Instances of the search string appear by line in the Search Results Cloud. The log information
displayed includes the line number in the log file in which the string is found, the date and time, the
server process involved, and the phrase or sentence containing the string.

Image: Logs page: Searching Log Files

This example illustrates the fields and controls on the Logs page: searching log files.

Setting up Log Management
On the Logs page, click the Log Management Setup link to display the Log Management Setup page
where you can define the log file types to manage for each target. You can add and remove log file types
as needed. From this page you can also schedule purge and archive jobs.
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Image: Log Patterns page

This example illustrates the fields and controls on the Log Patterns page.

Configuration
This table lists the common elements that are available for configuration targets.

Last Collected Click this to display the latest configuration data. The Last
Collected Configuration link enables you to view from a central
location key configuration metric and parameters for the target.

Compare Click this to compare configurations of multiple nodes.
 This helps to identify performance bottlenecks caused by
configuration changes.

Comparison Job Activity Click this to monitor comparison job status.

Search Click this to define the search criteria for configuration details
across targets.

History Click this to display the preserved configurations.

Save Click this to save the configuration for a given target.

Saved Click this to display the list of saved configurations for a given
target.

Topology Click this to display the topology configuration of the target
type.

Compliance
This table lists the common elements that are available for viewing compliance of targets.

Results Click this to evaluate the compliance of PeopleSoft targets
and systems for configuration, security, and storage. In
addition, compliance results provide advice on how to change
configuration to bring the PeopleSoft targets and systems into
compliance.
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Standard Associations Click this to associate the compliance standard for a target.

Real-time Observations Click this to define a search criteria to query the compliance
observations in the real time.

Target Setup
This table lists the common elements that are available for setting up targets.

Monitoring Configuration Click this to display target properties such as domain name, PS_
HOME, and PeopleTools version.

Administrator Access Click this to display access type and the privilege associated
with the target. You can add an administrator to a target.

Remove Target Click this to remove the current target from the system.

Add to Group Click this to add a target to a group.

Properties Click this to view and edit target properties.
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Discovering PeopleSoft Targets

Understanding the Discovery Process

Discovery is the process of an agent identifying predefined target types, registering them in Enterprise
Manager, and collecting their target properties and initial configuration data. The agent sends this data to
the Oracle Management Service, which processes the data and loads it into the Management Repository.
From there, Enterprise Manager can access data about the target to monitor and manage it.

Note: Discovery requires that the Enterprise Manager user be assigned the role of a super administrator.

Understanding Steps in the Discovery Process
The following steps outline how to initiate the discovery of PeopleSoft targets:

• From the PeopleSoft homepage, click Add Targets where you select the target types to be discovered.
Specify the host, discovery path for PS_HOMEs, PS_CFG_HOMEs, and PIA_HOMEs, and
subdirectory crawl depth.

See Adding Targets

• From the Target Credentials page, enter the credentials for the host where discovery executes.

• Select a target from the list of the PeopleSoft targets whose databases are discovered to register the
specific target in Enterprise Manager.

• Enter the information required to connect to the PROCESSREQUEST web service.

• Identify and register the Process Monitor target.

• Set environment variables for platforms requiring them, and add a PeopleSoft application database
(discovering a PS Application Database target).

See Adding and Registering Targets.

Note: With the Logical Grouping feature, consider the implications of your choices on the final steps of
the discovery process. In the final steps, the interface displays all the targets that the discovery process
located. The note on that last screen mentions that you need to click the OK button for the discovered
targets to become organized into Logical Groups for display on the All PeopleSoft Targets page. If the
you do not click OK, then all the targets discovered will display within the Unlinked Targets node. You
can organize the targets later into the correct logical grouping structure by using the Associate Unlinked
Targets to Logical Groups option on the Setup Logical Grouping screen.
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Understanding UNIX Login Shell Support
The PeopleSoft Application Management Plug—in supports the login shell for the user who installed
PeopleTools or created domains. This requires the user profile (.profile) to be set prior to discovery of
PeopleSoft targets. You must, first, setup the environment variables for PeopleSoft target discovery either
in .profile or psemenv.sh script.

Login shell support provides these advantages:

• Automatic discovery of the PS Application Database.

• Setting environment variables for each Tuxedo-based domain is not required.

• Less environment related issues.

When using a login shell, consider the following:

• There is an additional step to create a user profile either in the .profile or psemenv.sh if one
does not exist(if one does not exist).

• Only Bourne compatible shells (like sh, bash, and so on) are supported.

• Interactive login profiles are not supported.

Auto Discovery of Directly Discoverable Targets

The Auto Discovery feature enables you to automatically discover the targets. To discover the targets:

1. Login to Enterprise Manager

2. Navigate to Setup >Add Target >Configure Auto Discovery

Image: Configure Auto Discovery

Configure Auto Discovery

3. The Setup Auto Discovery Page Opens. Select the host and click on Discovery Modules.
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Image: Setup Auto Discovery

Setup Auto Discovery page

4. On the Discovery Modules Page, check the PeopleSoft Targets Discovery Module. As our intention is
to discover just the PeopleSoft targets, the other modules can be disabled as they are not in our scope
of interest at this point in time.

Image: PeopleSoft Targets discovery

PeopleSoft Targets discovery page

5. To Specify the Discovery Parameters, click Edit Parameters and fill out the required info (All
Mandatory) as shown in the below screenshot as an example and click OK.
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Image: Edit Parameteres

Edit parameters

6. Navigate back to the Setup Discovery Page and click Discover Now.

Image: Discover Now

Discover Now

7. The Discover Now activity gets initiated.
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Image: Discover Now — In Progress

Discover Now activity in progress

8. The Discover Now activity gets completed successfully.

Image: Discover Now — Completed

Discover Now activity completed.

9. The results from this run of the discovery module can be seen in the Auto Discovery Results page
that can be accessed by clicking on the link in Discovered Targets Column or via Setup >Add
Target >Auto Discovery Results
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Image: Auto Discovery results

Auto Discovery results

10. In the Auto Discovery Results page, the user should see the newly discovered PeopleSoft targets.
These targets will be in Not-Yet-Managed (NYM) state and will need to be promoted by assigning
Monitoring credentials.

Image: Promote Targets

Promote targets

11. In the Promote Discovered Target page, fill the details under the PeopleSoft Monitoring Creds,
PeopleSoft Secure Command Credentials and PeopleSoft Host Credentials sections and click
Promote.
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Image: Promote Discovered Targets

Promote Discovered targets page.

12. The target gets Promoted Successfully.

Image: Promote Target — Success page

Promote Target — Success page

13. The target shows up on the PeopleSoft Home Page.
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Image: Target on PeopleSoft Home Page

Target on PeopleSoft Home Page.

Note: If there are errors while running the Auto Discovery module, navigate to Configure Auto Discovery
menu, on Targets on Hosts tab, select the desired host target and click the Diagnostic Details button. This
page shows the error message from running discovery module. By selecting the PeopleSoft Discovery
Module on this Diagnostic Details page, click on Log from Agent button to retrieve logs from Agent side
as well.

Image: Diagnostic Details

Diagnostic Details

In the above context, the directly discoverable targets are the following:

• PS Application Server

• PS Process Scheduler
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• PS Search Server

• PS PIA

• PS Website

The remaining two target types, i.e. PS Application Database and PS Process Monitor will still need to be
discovered using either the existing guided discovery flow, or the EMCLI verb discovery approach.

Emcli verb based discovery of targets

There are three verbs defined for:

• psft_discover_direct_targets

• psft_discover_db_targets

• psft_discover_prcs_mntr_targets

Discovering directly discoverable targets
The verb psft_discover_direct_targets is used to discover the directly discoverable targets. To do this go to
OMS_BIN and execute the following:

./emcli psft_discover_direct_targets -configFile="/ds1/home/emagent/Oracle/Middlewa⇒
re/oms/bin/inputDirectTargets.properties"

Field Name Sample Value

host <HOST_NAME>

crawlDepth 2

targetList ps_app_serverps_piaps_home

discoveryPath <PS_CFG_HOME>

credName NC_PSOFT

credOwner SYSMAN

Discovering Database Target
The verb psft_discover_db_targets is used to discover the directly discoverable targets. To do this go to
OMS_BIN and execute the following:

./emcli psft_discover_db_targets -configFile="/ds1/home/emagent/Oracle/Middleware/o⇒
ms/bin/inputDbTargets.properties"

Field name Sample Value

host S854101R.app.slc06evj.ds1_home_psoft_psft_pt_854
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Field name Sample Value

targetName S854101R.app.slc06evj.ds1_home_psoft_psft_pt_854

targetType ps_app_server

credName NC_PSOFT

credOwner SYSMAN

At this point, only one db target gets discovered and this process does not create the system target. To
create a system target and to associate the targets to the system, click the Organize target button and
execute the logical grouping test case.

 Discovering the Process Monitor Target
The verb psft_discover_prcs_mntr_targets is used to discover the directly discoverable targets. To do this,
go to OMS_BIN and execute the following:

./emcli psft_discover_prcs_mntr_targets -  configFile="/ds1/home/emagent/Oracle/Mid⇒
dleware/oms/bin/inputPrcsMntrTargets.properties"

Field Name Sample value

host slc06evj.us.oracle.com

targetType ps_pia

credName NC_SLC06EVJ_PSOFT

credOwner SYSMAN

piaName S854903R.pia.slc06evj.ds1_home_psoft_psft_pt_854
wsdlUrl=http://<HOST_NAME>:<PORT>/PSIGW/
PeopleSoftServiceListeningConnector/QE_LOCAL/
PROCESSREQUEST.1.wsdl

userName QEDMO

userPwd QEDMO

At this point, only one prcs mntr target gets discovered. After discovery, the process monitor target needs
to be manually associated through the logical grouping.

Note: The property file is a name, value pair. The names have to be exactly the same as mentioned in the
above examples. The same applies to the format of the values to be passed.

Adding and Registering Targets

To add targets, see Adding Targets.
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After the discovery process completes, you must register the targets in Enterprise Manager.

To register PeopleSoft targets:

1. When discovery is finished, examine the displayed list of targets, and deselect any that you do not
want to register.

When the discovery process completes, a page displays a list of the discovered PeopleSoft targets that
are not yet registered in Enterprise Manager. Any targets previously discovered and registered are
excluded from the list. All listed targets are selected by default on the Add PeopleSoft Targets page.
Clear any discovered targets that you do not want to register.

Note: A PS PIA target can be registered without a corresponding PS Web Site target. However, a PS
Web Site target cannot be registered without also having a registered PS PIA (parent) target.

Note: To register a PS Process Monitor target, there must be a corresponding PS PIA target.

2. Click Next.

All targets selected are registered in Enterprise Manager. Their initial configuration values are
collected and loaded into the repository.

The discovery process continues for the Process Monitor setup if there are any PS PIA targets. After
clicking Next, it continues for the PS Application Databases.

Note: Before a PS Process Monitor target can be discovered, you need to configure the
PROCESSREQUEST web service for use within Integration Broker and Process Scheduler.

See Adding and Registering PS Process Monitor Targets.

3. Specify any required environment variables.

The Add PeopleSoft Application Database page appears showing a list of targets for which
environment variables may need to be set.

This step is optional with the PeopleTools 8.50 and later versions of the PeopleSoft AMP. Verify that
the user profile is correctly set with the required environment variables.

The list includes all PS Application Server Domains, PS Process Scheduler Domains, and PS Search
Server Domains registered in Enterprise Manager in this or a previous discovery.

  Set Environment Variables Click to configure settings that enable connection to an
application database—use this following your selection in
the Select column.

  Select Check box to determine for which targets you want to allow
editing of the environment variables.

  Name Name of the PS Application Server Domain, Process
Scheduler Domain, or PS Search Server Domain that can
have a PS Application Database.
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This value displays as a link to the target homepage, which
you can select to open in a new window.

  Target Type The type of target being registered.

  DB Type The type of database to which the target is connecting.

  Environment Set Shows a green check mark when environment variables
have been set for the database (if required for a specific
database type). Shows a red X when environment variables
have not been set.

The environment variables referred to in this field are
database connectivity parameters and vary depending on the
database type.

  Databases Discovered Shows a green check mark when the application database
is successfully discovered which means that Enterprise
Manager can collect configuration data from the target and
collect the PeopleSoft GUID from the application database.

Shows a red X when discovery is unsuccessful. Possible
reasons are:

• The environment variables have not been set correctly.
 Verify them on the Set Environment Variables page.

• The database information is incorrect. Select the target
to open it in a new window. Select the Administration
tab, then Configure Domain to display configuration
data. Validate database information here.

• The configuration collection has failed. Select the link
for the target in the Name column. The target homepage
appears where you can check for metric collection errors
displayed above the Incidents section.

  Discover Related Databases Click this icon to initiate discovery.

4. Click Next.

The green check mark indicates that the application database associated with that target is registered
in Enterprise Manager.

Note: If you need to set environment variables, see the following section.

5. When prompted, click OK on the confirmation pages. When finished, click Next.

The processing page for registering the specific application database appears. When complete, the
system displays a page reporting the summary of discovery results. Once reviewed, click OK.

6. The PeopleSoft homepage appears showing the newly discovered targets.
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Note: There is a difference between creating a target and adding a target. If you use the create feature,
Enterprise Manager creates a new domain on the managed host. If you use the add feature (Add
PeopleSoft Targets), Enterprise Manager searches for existing domains in the managed host that have not
been registered in the Enterprise Manager.

Setting Environment Variables
Setting environment variables means specifying basic database connectivity parameters for the
database type you are using. When you select Set Environment Variables for any target, the Set
Environment Variables page appears showing two columns listing the required environment variables and
corresponding values.

Note: Setting environment variable entries are applicable when the profile is not set for a login shell
script.

After you have entered the values on the Set Environment Variables page, they are added to the
Environment Variables list if they do not already exist. Therefore, based on the database type previously
configured, the regions on this page may have tables prepopulated with the required environment
variables.

Database Type Required Environment Variables

Oracle $ORACLE_HOME

Informix $INFORMIXDIR

$INFORMIXSERVER

Sybase $SYBASE

$SYBASE_OCS

DB2OS390 $DB2DIR

$DB2INSTANCE

DB2UNIX $DB2DIR

$DB2INSTANCE

Get the correct values of DB2DIR and DB2INSTANCE from
the command console on the host machine. For example:

pt-ibm03:$ . ./psconfig.sh
pt-ibm03:$ echo $DB2DIR
/opt/IBM/db2/V9.1
pt-ibm03:$ echo $DB2INSTANCE
db2udb9

Microsoft SQL Server Entry of environment variables is not required. The default
values from MSSQLSERVER are inserted.
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Note: The environment variable values are not validated when you enter them. Furthermore, an agent
does not inherit the environment variable values of the user initiating an action. For an action to be
successful, values for environment variables must be set correctly.
By default, some environment variables appear on the Set Environment Variables page that displays
during discovery (see table above), where you can set the values. However, other environment variables,
such as LD_LIBRARY_PATH, PATH, SHLIB_PATH, and LIBPATH may also need to be set for each
discovered domain.
If you have only one installed PeopleTools and Tuxedo version on a managed host machine, you can set
environment variables for an agent prior to starting that agent. However, if you have multiple installed
versions of PeopleTools or Tuxedo on a managed host machine, the environment variables must be set for
each discovered domain as part of the discovery process.

When using a login shell script, the following variables are required to be defined in the $HOME/.profile
(similar to the table above).

• Common environment variables: LD_LIBRARY_PATH, PATH, SHLIB_PATH, LIBPATH

• Database-specific variables: ORACLE_HOME, ORACLE_SID, TNS_ADMIN, INFORMIXDIR,
INFORMIXSERVER, SYBASE, SYBASE_OCS, DB2DIR, DB2INSTANCE

• Tuxedo: TUXDIR

Note: There are multiple ways to update $HOME/.profile. The following is only an example.

To modify the $HOME/.profile:

1. Start a new telnet session as the appropriate user ID (posft, emagent, and so on).

2. Select the correct values at the login prompt for database, SQR, COBOL, and so on.

3. Use <set> or <env> commands to retrieve the values of the necessary environment variables.

4. Update $HOME/.profile with these environment variables, using the VAR=<value>; export VAR
syntax.

5. Logout and log into a new telnet session as the same user ID and make sure you see a message
indicating that a .profile exists.

For example:

WARNING: .profile exists, bypassing /etc/profile

The following example illustrates a sample .profile for a PeopleSoft user in a multiuser configuration:

ORACLE_HOME=/ds1/home/oracle/Oracle/Database/product/11.2.0/dbhome_1; export ORACLE⇒
_HOME
TNS_ADMIN=/ds1/home/psoft; export TNS_ADMIN
TUXDIR=/ds1/home/psoft/bea/tuxedoPS2/tuxedo11gR1; export TUXDIR
LD_LIBRARY_PATH=$TUXDIR/lib:$ORACLE_HOME/lib:$LD_LIBRARY_PATH; export LD_LIBRARY_PA⇒
TH
SHLIB_PATH=$TUXDIR/lib:$ORACLE_HOME/lib:$SHLIB_PATH; export SHLIB_PATH
LIBPATH=$TUXDIR/lib:$ORACLE_HOME/lib:$LIBPATH; export LIBPATH
PATH=$TUXDIR/bin:$ORACLE_HOME/bin:$PATH; export PATH

48  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 3 Discovering PeopleSoft Targets

Note: If you use the psemenv.sh script approach, you can set the same environment variables in the
HOME directory or in the PS_CFG_HOME directory where you have created the PeopleTools domains.
See, Using the PSEMENV.SH Script for Setting Environment Variables.

Adding and Registering PS Process Monitor Targets

This section provides an overview and discusses:

• Configuring PROCESSREQUEST Web Service.

• Adding PS Process Monitor Targets From Discovery Results Page.

• Adding PS Process Monitor Targets From the Process Monitor Setup Page.

• PS Process Monitor Configuration Variables.

• Working with custom SSL configurations.

Understanding PS Process Monitor Discovery
Registering PS Process Monitor targets requires a few additional steps that need to be completed prior to
the discovery process. Before you can discover and register a PS Process Monitor target, at least one PS
PIA target needs to be discovered, and the PROCESSREQUEST web service must be published through
the Integration Gateway.

You discover and register PS Process Monitor targets using:

• Add PeopleSoft Targets: Discovery Results page.

• Process Monitor Setup page.

Note: From PeopleTools version 8.56, the PROCESSREQUEST web service is part of PeopleTools
database. Users need to execute the IB Template available in Automatic Configuration Templates. This
will perform the IB configuration. Once the IB configuration is done, Users can proceed to discover the
Process Monitor. On Process Monitor Discover page, click the Fetch WSDL button to fetch the wsdl from
the PeopleTools Database. Users can proceed to discover process monitor after entering the User Name
and Password,

Note: If the Process Monitor Discovery did not complete successfully, then verify if all the steps
mentioned in Configuring PROCESSREQUEST Web Service is in place.

The following information assumes that you have a working knowledge of PeopleSoft Integration Broker
and have it configured in your environment.

See the product documentation for PeopleTools: Integration Broker.

Configuring PROCESSREQUEST Web Service
To configure the PROCESSREQUEST web service:

1. Configure Integration Broker for your environment.
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Make sure to specify a Secure Target Location.

Note: The PROCESSREQUEST web service is enabled by default in PeopleTools 8.56 and
PeopleSoft Applications built on PT8.56 and higher. Hence PeopleTools 8.56 and higher does not
require you to perform the steps from 2 to 7.

2. Select PeopleTools > Integration Broker > Integration Setup > Services, enter PROCESSREQUEST,
and click Search.

3. Open each service operation and verify that Security Verification is set to one of the following:

• Encrypt/Digital Sign or SSL

• Encrypt or SSL

• Digital Sign or SSL

• SSL

4. Select PeopleTools > Integration Broker > Web Services > Provide Web Service open
PROCESSREQUEST on the Select Services page, and click Next.

5. On the Select Service Operations page, select Use Secure Target Location, (to create a secure end
point address in WSDL), select these service operations, and then click Next.

• FindRequests

• GetParams

• GetProcessNames

• GetPrompt

• GetReport

• GetRequest

• GetServerConstraints

Note: GetServerConstraints service operation is included only for PeopleTools 8.54 version and
above.

• Schedule

• UpdateRequest

Note: Version v1 must be set as the default for FindRequest, GetPrompt, and GetRequest service
operation. You must include v1 for FindRequest, GetPrompt, and GetRequest service operation in the
PROCESSREQUEST web service.

6. On the View WSDL page, click View WSDL to verify the generated WSDL, and click Next.

7. On the Specify Publishing page, click Finish, and copy the generated WSDL URL, which you will
need when you discover and set up the PS Process Monitor target.
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8. Configure the distribution agent.

a. Select PeopleTools, Process Scheduler, Report Nodes, select the Add a New Value tab, enter
PRCSMNTRNODE, and click Add.

b. Select Ftp/XCopy.

c. Enter the URL as: http://<host>:port/psreports/<site>

d. Enter Network Path as: \\<host>\psreports

e. Click Save.

9. Configure server definition.

a. Select PeopleTools, Process Scheduler, Servers.

b. Select the appropriate server (PSNT, PSUNX, and so on).

c. Select the Distribution tab and enter Distribution Node Name as PRCSMNTRNODE.

d. Select the Transfer System Files to Report Repository check box.

e. Click Save.

Note: The replicate PIA may fail due to redundancy in classpath. For workaround, see E-PSEM: Oracle
Enterprise Manager - Setup Process Monitor for Peoplesoft PIA (Doc ID 1620052.1).

Adding PS Process Monitor Targets From Discovery Results Page
During the typical discovery process, you have the option to add and register PS Process Monitor targets.
The Add PS Process Monitor page can be launched only if a PS PIA target has been discovered and
selected.

Note: For discovering PS Process Monitor targets, the PeopleTools version for the PS PIA target must be
at least PeopleTools 8.50.

Working With Custom SSL Configurations
During PS Process Monitor discovery, the EM Agent communicates with Integration Broker over HTTPS
using the default SSL configuration setup.

The following process outlines the typical Process Monitor discovery workflow, which existed in
previous releases, and is supported by default in the current release, as well.
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Image: Discover Process Monitor

Discover Process Monitor

1. Discover the PIA target.

2. Use the PIA target in the All PeopleSoft Targets page, to discover the Process Monitor target.

3. In the Process Monitor discovery page, enter the WSDL URL or click the Generate WSDL URL
button to fetch the WSDL url.

4. Discover the PS Process Monitor target.

This "typical" process:

• uses the default SSL configuration.

• makes no changes to the pskey.properties file.

• keeps the property useCustomSSLConfiguration set to false (the default).

Additionally, the PeopleSoft plug-in supports EM Agent communicating with Integration Broker using a
custom SSL configuration. The high-level steps for setting up the custom SSL configuration are:

1. Export the default signer certificate presented by the web server (WebLogic or WebSphere) for
HTTPS communication (using the keytool utility).

2. Import this signer certificate into the keystore pskey used by the EM Agent using the keytool utility.

3. In pskey.properties file, enable the following property for the custom configuration setup:

useCustomSSLConfiguration=true

4. Restart the EM Agent and discover the Process Monitor target with the custom SSL configuration
setup.

When using the custom SSL configuration, you import the signer certificate of the web server (WebLogic
or WebSphere) into the agent’s custom keystore file which by default is: $AgentHome/sysman/config/
pskey.

Note: The EM Agent’s keystore file (pskey) and properties file (pskey.properties) is required for
implementing this feature and can be found in the directory $AgentHome/sysman/config.

Retrieving Signer Certificate from WebLogic
To retrieve the signer certificate:

1. Verify the signer certificate.
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a. Go to the PIA signon URL using an HTTPS port.

b. Click View Certificates.

The certificate is displayed.

c. Click Export to export the certificate.

d. Save the certificate.

2. Export this signer certificate from the WebLogic keystore file, cacerts, using the keytool utility.

For example:

$Agent_Home/jdk/bin/keytool -export -rfc -keystore cacerts -alias certgencab
-file certgencab.cer -storepass changeit -keypass changeit

Note: If using a custom SSL configuration on WebLogic, you may need to export the appropriate
signer certificate from the keystore, cacerts.

3. Import the signer certificate file certgencab.cer into the Agent’s custom keystore file, pskey, using the
keytool utility.

For example:

$Agent_Home/jdk/bin/keytool -import -noprompt -trustcacerts -alias
certgencab -file certgencab.cer -keystore pskey -storepass password

4. Edit the pskey.properties file and ensure:

• custom keystore location and other attributes are properly set.

• useCustomSSLConfiguration is set to true.

Retrieving Signer Certificate from WebSphere
To retrieve the signer certificate from WebSphere:

1. Extract the signer certificate.

Login to WebSphere administration console, and navigate to Security, SSL certificate and key
management, Key stores and certificates, NodeDefaultTrustStore, Signer certificates.

Select the default signer certificate, root, and click Extract.

This will extract the certificate into the given location in ASCII text mode by default.

Note: If you are using a custom SSL configuration on WebSphere, you may have to extract the
appropriate signer certificate from the keystore, NodeDefaultTrustStore.

2. Import this signer certificate file, rootWAS.cer, into the Agent’s custom keystore file, pskey, using the
keytool utility.
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For example:

$Agent_Home/jdk/bin/keytool -import -noprompt -trustcacerts -alias rootWAS
-file rootWAS.cer -keystore pskey -storepass password

3. Edit the pskey.properties file to ensure:

• the custom keystore location and other attributes are properly set.

• useCustomSSLConfiguration is set to true.

Related Links
RSA Certificate Issues on WebSphere
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Understanding PeopleSoft Application Database Targets

The PeopleSoft Application Database target type refers to the database that contains the PeopleSoft
application. The application database target type is not intended to manage the underlying database
(RDBMS) itself. However, depending on your database type, Enterprise Manager may provide additional
management and monitoring features.

If the database is Oracle, you can monitor and manage the database by selecting Targets > Database from
the Enterprise Manager page.

Note: If you have backed up, and then restored a database, you must set the GUID in the database to
blank before attempting the discovery process.
To get the current value of the database GUID, execute the following SQL Statement:
select GUID from PSOPTIONS
Then, depending on your database syntax, execute the appropriate update statement to set the GUID
column in PSOPTIONS to ' '. For example:
update PSOPTIONS set GUID = ' '
The next time an application server connects to the database, the system generates a new unique GUID
for that database.

Accessing the PeopleSoft Application Database Page

From the All PeopleSoft Targets page, click the application database link.

Image: PS Application Database Target page

This example illustrates the fields and controls on the PS Application Database homepage

Click thePeopleSoft Application Database link to:
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• Monitor the PeopleSoft Application Database.

See Monitoring.

• Control the PeopleSoft Application Database.

See Control.

• View job activity.

See Job Activity.

• View information publisher reports.

See Information Publisher Reports.

• Configure targets.

See Configuration.

• Validate compliance.

See Compliance.

• Setup target.

See Target Setup

• View target Information.

See Common Elements on Targets Homepages.
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Understanding PeopleSoft Application Server Domain Targets
Homepage

This target type enables an administrator to manage PeopleSoft application server domains.

Note: Many of the features and concepts in this section are described in PeopleTools 8.54: System and
Server Administration.

Select Targets > PeopleSoft and then click the specific application server that you want to view.

Image: PS Application Server page

This example illustrates the fields and controls on the PS Application Server homepage

Click the PeopleSoft Application Server Domain link to:

• Monitor the PS Application Server Domain.

See Monitoring.

• Control the PS Application Server Domain.

See Control

• View job activity.
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See Job Activity

• View information publisher reports.

See Information Publisher Reports.

• View performance.

See Performance.

• Manage configuration.

To configure domain, see Configuration Management, “Configure Domain”.

To create like domain, see Configuration Management, “ Create Like Domain”.

To copy domain, see Configuration Management, “ Copy Configuration”.

To discover database, see Understanding the Discovery Process and Creating and Configuring
PeopleSoft Application Server Domain Targets

• Manage domain.

See Domain Management.

• Manage logs.

See Log Management Page

• Configure targets.

See Configuration

• Validate compliance.

See Compliance

• Setup target.

See Target Setup

• View target Information.

See Common Elements on Targets Homepages.

Creating and Configuring PeopleSoft Application Server Domain
Targets

This section provides an overview of creating and configuring PeopleSoft targets and describes how to:

• Create PS Application Server domain targets.

• Configure PS Application Server domain targets.
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Creating PeopleSoft Application Server Domain Targets
The Enterprise Manager user must have a super administrator privilege to create new application server
domain target. It is important to set the correct environment variables for new domains created within
Enterprise Manager. For more information about setting setting environment variables, see Setting
Environment Variables.

1. Select Targets >PeopleSoft >Create to access the Create PeopleSoft Application Server Domain
page.

Image: Create PeopleSoft Application Server Domain page

This example illustrates the fields and controls on the Create PS Application Server Domain page.
You can find definitions for the fields and controls later on this page.

Enter all the required parameters and then click OK.

  Domain Enter a unique name (within the host) not greater than 8
characters and not containing any spaces or punctuation
marks.

  Host Click the icon to display the Host Target selection window,
 and select the host where you want to create the domain.

  PS_HOME Based on the host, the available list is limited to the PS_
HOMEs on the host that contain the software necessary to
create a domain.

You can discover additional PS_HOMEs to augment this
list. If you click Discover PS_HOMEs in the Related
Links region of this page, the Add PeopleSoft Targets page
with the PS_HOME/PS_CFG_HOME check box selected
appears. Continue through the discovery process, when
finished, control returns to this page.

 PS_CFG_HOME Specify the location of PS_CFG_HOME.

• Existing: To use an existing PS_CFG_HOME location,
 select the value from the drop-down list.

• New: To enter a new location (as opposed to using the
existing location) enter that value in the New field.
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• Same as PS_HOME: To install the PS_CFG_HOME
within the PS_HOME location, select this check box.
 The system automatically populates the New field with
the specified PS_HOME.

  Configuration Template Select a template from the drop-down list.

(Optional) Click Get Latest Configuration Templates in
the Related Links region of this page to retrieve the latest
template list from the host. You are required to enter your
credentials in a subsequent page to connect with a managed
host.

The configuration template you select determines the default
values of the domain.

There are predefined configuration templates based on
the number of concurrent users expected to connect to the
domain. The following provides a general guideline:

• Small (1-50 users)

• Medium (50-500 users)

• Large (500-1000 users)

• Developer (for a development or test system)

  Configure Domain Default selection is to configure the domain. If selected, the
Configure Domain page appears after the domain is created.

  Import Domain Configuration from
file

Select to enable the entry of the filename and path of the
host's configuration file.

Ensure that the source configuration file resides in the host
or an error appears during the create process. Use the Find
icon to verify the path or to populate this field by selecting
the path to the file.

The Browse and Select: File and Directory page opens in a
separate browser. Select folders to drill down further until
the desired file is found. Select the file and click Select.

If you do not import the configuration from a file, click OK.

The domain will be created without a configuration. You
can configure the domain at a later time by selecting the
Configure Domain link from the Administration tab of the
target.

 Import IB Master Domain from
Configuration File

For Integration Broker environments, you can implement
master-slave configurations with the Integration Broker
server domains. Select this option to import previously
configured master domain configurations.
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See PeopleTools 8.54: PeopleSoft Integration Broker
Administration

Filename in Host Need Info

2. On the Enter Credentials for the host page, select the credentials and then click OK.

For more information about preferred credential and named credential, see <link>

3. Click OK on the Confirmation page.

Image: Enter Credentials for the host page

This example illustrates the fields and controls on theEnter Credentials for the host page. You can find
definitions for the fields and controls later on this page.

Credential Specify the credentials. The credential that you select becomes
the preferred and monitoring credential for the discovered or
newly created targets.

Preferred Credential Name Target Preferred Credentials is a credential specifically applied
to a single target for a particular user.

See Managing Target Preferred Credentials.

Credential Details Specify the user name and password for the target.

More Details Click this to view more details about the credential creation.

Configuring PeopleSoft Application Server Domain Targets
In the PeopleSoft environment, you would use PSADMIN to create and configure your domains. When
using the PeopleSoft Application Management plug-in, you use the browser interface of the Enterprise
Manager Cloud Control console. The options available in PSADMIN are replicated in the console. For
information on each domain parameter, refer to the Oracle PeopleTools documentation.

See PeopleTools 8.54: System and Server Administration, “Setting Application Server Domain
Parameters”

For example, when configuring a domain, you have the option to use the Quick Configuration interface,
similar to the PSADMIN option. This appears if you selected Configure Domain on the Create PS
Application Server Domain page, and after clicking OK on the page indicating your domain has been
successfully created.
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Image: Quick Configuration page

This example illustrates the fields and controls on the Quick Configuration page

If you need to drill into specific configuration sections, like performing a custom configuration in
PSADMIN, click the specific link from the Configuration Sections pane to modify the parameters.

Note: You cannot edit the password field from the Quick Configuration section.

For more information about PSADMIN configuration, refer to the following:

• See the product documentation for PeopleTools: System and Server Administration, “Using the
PSADMIN Utility,” Understanding PSADMIN

• See the product documentation for PeopleTools: System and Server Administration, “Using
PSADMIN Menus,” Understanding PSADMIN Menus

• See the product documentation for PeopleTools: System and Server Administration, “Working with
PSADMUTIL,” Understanding PSADMUTIL
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Understanding the PeopleSoft Process Scheduler Domain page

This target type enables an administrator to manage PeopleSoft process scheduler domains.

Select Targets > PeopleSoft then select the desired PS Process Scheduler Domain target.

Image: PeopleSoft Process Scheduler Domain page

This example illustrates the fields and controls on the PS Process Scheduler Domain homepage.

Click the PeopleSoft Process Scheduler Domain link to:

• Monitor the PS Process Scheduler Domain.

see Monitoring..

• Control the PS ProcessScheduler Domain.

See Control.

• View job activity.

See Job Activity.

• View information publisher reports.

See Information Publisher Reports.

• View performance.
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See Performance

• Manage configuration.

To configure domain, see Configure Domain.

To create like domain, see Create Like Domain.

To copy domain, see Copy Configuration.

To discover database, see Understanding the Discovery Process and Creating and Configuring
PeopleSoft Application Server Domain Targets

See Domain Management.

• Manage logs.

See Log Management Page.

• Configure targets.

See Configuration.

• Validate compliance.

See Compliance.

• Setup target.

See Target Setup

• View target Information.

Creating PS Process Scheduler Domain Targets

You create a PS Process Scheduler domain in the same way that you create a PS Application Server
domain.

See Creating PeopleSoft Application Server Domain Targets.
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Understanding PeopleSoft Search Server Domain Targets

The PS Search Server Domain target type allows for the application server search function in PeopleSoft
applications.

The PS Search Server Domain enables you to:

• Centralize search functions.

• Implement a search server on a platform separate from the application server.

• Run application server domains on operating systems that may not be supported by Verity.

One search server domain can be associated with more than one application server domain, however, an
application server domain can have just one search server.

Important! Search server targets are only those configured within PSADMIN to run with Verity, not
those configured for Oracle SES and the PeopleSoft Search Framework.

Accessing PeopleSoft Search Server Domain Targets

Select Targets > PeopleSoft then select a PS Search Server Domain target..
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Image: PeopleSoft Search Server Domain Target page

This example illustrates the fields and controls on the PS Search Server Domain Homepage. You can find
definitions for the fields and controls later on this page.

Click the PeopleSoft Process Scheduler Domain link to:

• Monitor the PS Process Scheduler Domain.

see Monitoring..

• Control the PS ProcessScheduler Domain.

See Control.

• View job activity.

See Job Activity.

• View information publisher reports.

See Information Publisher Reports.

• View performance.

This page displays the same information as the PS Process Scheduler Domain Performance page
except that the process in the Queued Process graph is the PSSRCHSRV.

See Performance

• Manage configuration.

You can do the following:

• Configure Domain.

• Discover Database.

For more information about configuration management, see Configuration Management.

• Manage domain.
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See Domain Management.

• Manage logs.

See Log Management Page.

• Configure targets.

See Configuration.

• Validate compliance.

See Compliance.

• Setup target.

See Target Setup

• View target Information.

Creating a PS Search Server Domain

Select Targets >PeopleSoft >Create to access the Create PeopleSoft Application Search Server Domain
page. The Import Configuration from File option is not available when creating a PeopleSoft Search
Server Domain.

Note: Not all platforms support a separate search server domain. Therefore, the system checks whenever
you try to create a search server domain manually. If a separate search server domain target type is not
supported on your platform, an error occurs.

See Creating and Configuring PeopleSoft Application Server Domain Targets
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Managing PS PIA and PS Web Site Targets

Understanding PeopleSoft PIA Targets

The PS PIA target acts as a container for one or more PS Web Site targets and together they are a
PeopleSoft Web server.

The PS PIA target can be compared to a domain in Weblogic and a server in WebSphere.

Note: Before attempting to discover or access a PS PIA and PS Web Site in Enterprise Manager, verify
that your PeopleSoft application is running and that you can log in from a PIA page.

Select Targets > PeopleSoft then select the desired PS PIA target.

Image: PeopleSoft PIA page

This example illustrates the fields and controls on the PS PIA homepage.

Click the PeopleSoft PIA link to:

• Monitor thePeopleSoft PIA Domain.

See Monitoring

• Control the PeopleSoft PIA Domain.

See Control

• View job activity.

See Job Activity

• View information publisher reports.
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See Information Publisher Reports

• View performance.

See Performance.

• Manage PIA.

See Managing PIA.

• Manage logs.

See Log Management Page

• Configure targets.

See Configuration

• Validate compliance.

See Compliance

• Setup target.

See Target Setup

• View target Information.

See Common Elements on Targets Homepages

See the product documentation for PeopleTools: Portal Technology, “Configuring the Portal
Environment.”

Creating PeopleSoft PIA Domains Target

These instructions assume you have a working knowledge of the topics described in the PeopleTools
installation guide and System and Server Administration PeopleBook related to the PeopleSoft Pure
Internet Architecture implementation.

See PeopleTools 8.54 Installation for <your platform>

See PeopleTools: System and Server Administration

To create a PIA domain from Enterprise Manager Cloud Control:

1. Navigate to Targets >PeopleSoft >Create >PS PIA.

2. On the Create PS PIA : Input Screen 1 page, enter the required details.
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Image: Create PIA : Input Screen 1 page

This example illustrates the fields and controls on the Create PIA : Input Screen 1 page. You can find
definitions for the fields and controls later on this page.

 Domain Enter the name of the new PS PIA domain.

 Host Select the host server where you intend to install the new
PIA domain.

 PS_HOME Select the appropriate PS_HOME on the selected host.

 PIA_HOME Enter the location where you want to install the PIA domain
files (the \webserv directory).

• Existing: Select from previously installed PIA_HOMEs,
 with the default displaying the configured PS_CFG_
HOME location.

• New: If you intend to install the new PIA domain in a
different location, enter that location in the New edit
box.

• Same as PS_HOME:  Select to install the PIA domain
within the PS_HOME directory structure

 Web Server Select your web server product: Oracle WebLogic or IBM
WebSphere.

 Install Action Select the type of domain you want to install, single or
multiserver.

See PeopleTools 8.54 Installation for <your platform>:
"Setting Up the PeopleSoft Pure Internet Architecture"

3. On the Create PIA : Input Screen 2 page, enter the required parameters.
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Image: Create PIA : Input Screen 2 page

This example illustrates the fields and controls on the Create PS PIA (screen 2). You can find
definitions for the fields and controls later on this page.

 Web Server Home The location of your web server product installation.

 Web Server Admin User ID Enter the user ID used to signon to the web server
administration console.

 Web Server Admin User Password Enter the password used to signon to the web server
administration console. (Retype the password to confirm
your entry).

Retype Web Server Admin Password

 Web Site Enter the name of the web site included in the domain.

 App Server Name Enter the host on which the application server domain runs.

 JSL Port Enter the Jolt listening port for the application server
domain.

 HTTP Port Enter the HTTP port on which the web server listens.

 HTTPS Port If SSL is configured, enter the HTTPS port on which the
web server listens.

 Authentication Token Domain Enter the authentication token domain, if required.

 Web Profile Name Enter the name of the web profile to be used.

 Web Profile User ID Enter the user ID and password associated with the selected
web profile. (Retype the password to confirm your entry).

Web Profile Password Enter the Web profile password.

Retype Web Profile Password Re-enter the Web profile password.
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 Report Repository Location The Process Scheduler report output location.

Integration Gateway User Id Enter the Integration Gateway ID.

Integration Gateway Password Enter the Integration Gateway password.

Re-type Integration Gateway
Password

Re-enter the Integration Gateway password.

App Server Domain Connect
Password

Enter the App Server Domain Connect password.

Re-type App Server Domain Connect
Password

Re-enter the App Server Domain Connect Password.

4. On the Target Credentials page, enter the credentials required to install a new domain on the selected
host.

5. Monitor the PS PIA installation process using the on screen display.

6. When completed successfully, click OK on the PIA Installation Status page.

7. Start the PIA domain, and sign on to test the installation.

Starting and Stopping Targets Using Jobs
The Oracle Enterprise Manager framework allows the automation and delegation of routine tasks on
multiple targets. These tasks are completed using jobs, which you define on the Jobs tab in the Enterprise
Manager console. The PeopleSoft AMP provides these predefined jobs to manage selected PeopleSoft
targets:

• Start PeopleSoft Domains

• Stop PeopleSoft Domains

Creating start and stop jobs applies to these PeopleSoft targets:

• PS PIA

• PS Application Server Domain

• PS Process Scheduler Domain

• PS Search Server Domain

Note: Prior to including a target in a job, it must first have been discovered.

Note: If multiple targets are included in the job, they can reside on separate hosts.
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Image: Create Job page

This example illustrates the fields and controls on the Create Job page.

To create a Start/Stop PeopleSoft Domain job:

1. Select Enterprise >Jobs >Activity.

2. On the Job Activity page, select one of the following from the Create Job dropdown:

• Start PeopleSoft Domains

• Stop PeopleSoft Domains

3. On the General subtab:

• Enter a job name and description.

• Select the appropriate value from the Target Type dropdown: PS Application Server Domain, PS
PIA, PS Process Scheduler Domain, PS Search Server Domain.

• Click Add to display a list of applicable targets, and select the targets you wish to include in the
job.

4. Skip the Parameters subtab (it does not apply).

5. On the Credentials subtab, select the credentials for the job to use.

6. On the Schedule subtab, specify whether the job should run immediately, a specific time in the future,
or on a repeating schedule.

7. On the Access subtab, modify any required user access to the job.

To see the job result, select Jobs, Job Activity, and click the desired job on the Job Activity page.

Note: The Start PIA job for PIA domains running on Oracle WebLogic in a Microsoft Windows server
environment will not terminate as "Succeeded" due to the limitation with startPIA script not running as a
background process on Windows. The job status may be shown as "Running." See the job details output
to confirm that the PIA domain has started.

For more information about Oracle Enterprise manager, see Oracle Enterprise Manager Cloud Control
Documentation
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Managing PIA

Click PeopleSoft PIA >PIA Management to:

Image: PeopleSoft PIA - PIA Management menu

This example illustrates the elements in the PIA Management menu

Redeploy PIA See Redeploy PIA Page.

Recreate WebLogic Server Domain
and Redeploy PIA

See Recreate WebLogic Server Domain and Redeploy PIA
Page.

Install Additional PeopleSoft Site See Install Additional PeopleSoft Site Page.

Replicate PIA See Replicate PIA.

Start PIA Click this to start PIA. Click OK on the confirmation page.

Stop PIA Click this to stop PIA. Click OK on the confirmation page.

Setup Process Monitor See Setup Process Monitor.

Redeploy PIA Page
This selection affects all of the PeopleSoft Pure Internet Architecture web applications installed to
the local domain. Select this option to redeploy all of the class files and jar files that comprise web
components of PeopleSoft Pure Internet Architecture. Server configuration files, scripts and any existing
PeopleSoft (PORTAL) sites are not overwritten, unless you specify an existing PeopleSoft site during this
setup.

1. Select PeopleSoft PIA >PIA Management >Redeploy PIA to access the Redeploy PIA : Input Screen
1 page.

2. Click Next to access the Redeploy PIA : Input Screen 2 page.
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Image: Redeploy PIA : Input Form(Contd.) pag

This example illustrates the fields and controls on the Redeploy PS PIA (Screen 2)

Notice that some of the fields are populated with existing values and cannot be edited.Enter the fields
marked *.

Web Server Admin Password Enter the password used to signon to the web server
administration console.

App Server Name Enter the host on which the application server domain runs.

Authentication Token Domain
(like.mycompany.com)

Enter the authentication token domain.

Web Profile Password Enter the Web profile password.

Retype Web Profile Password Re-enter the Web profile password.

Report Repository Location The Process Scheduler report output location.

Integration Gateway Password Enter the Integration Gateway password.

Retype Integration Gateway
Password

Re-enter the Integration Gateway password.

App Server Domain Connect
Password

Enter the App Server Domain Connect password.

Re-type App Server Domain Connect
Password

Re-enter the App Server Domain Connect password.

3. On the Redeploy PIA : Credential Screen, select the credentials and then click Next.

4. Click OK on the Redeploy PIA : Confirmation Screen.

See the product documentation for PeopleTools Installation for your database platform, "Setting Up the
PeopleSoft Pure Internet Architecture"
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Recreate WebLogic Server Domain and Redeploy PIA Page
This option applies only to Oracle WebLogic Server configuration and all of the PeopleSoft Pure Internet
Architecture web applications installed to the local Oracle WebLogic domain. Select this option to
completely remove an existing Oracle WebLogic domain and create the newly specified PeopleSoft site.

Note: Stop the PS PIA target before initiating PIA install action.

1. Select PeopleSoft PIA >PIA Management >Recreate WebLogic Server Domain and Redeploy PIA to
access the Recreate WebLogic Server Domain and Redeploy PIA : Input Screen 1 page.

2. Select the Install Action to specify the type of domain you want to install, single or multiserver.

See PeopleTools 8.54 Installation for <your platform>: "Setting Up the PeopleSoft Pure Internet
Architecture"

3. Click Next to access the Recreate WebLogic Server Domain and Redeploy PIA : Input Screen 2 page.

Image: Recreate Weblogic Server Domain and Redeploy PIA : Input Form(Contd.)

This example illustrates the fields and controls on the Recreate WebLogic Server Domain and
Redeploy PIA : Input Screen 2 page. You can find definitions for the fields and controls later on this
page.

Some of the fields are populated with values. Enter the fields marked *.

App Server Name Enter the host on which the application server domain runs.

Authentication Token Domain
(like.mycompany.com)

Enter the authentication token domain.

Web Profile Password Enter the Web profile password.

Retype Web Profile Password Re-enter the Web profile password.

Report Repository Location The Process Scheduler report output location.

Integration Gateway Password Enter the Integration Gateway password.

Retype Integration Gateway
Password

Re-enter the Integration Gateway password.
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App Server Domain Connect
Password

Enter the App Server Domain Connect password.

Re-type App Server Domain Connect
Password

Re-enter the App Server Domain Connect password.

4. On the Recreate WebLogic Server Domain and Redeploy PIA : Credential Screen, select the
credentials and then click Next.

5. Click OK on the Recreate WebLogic Server Domain and Redeploy PIA : Confirmation Screen.

Install Additional PeopleSoft Site Page
This option is relevant only to the PeopleSoft Portal web application, and does not modify or revert any
other configuration settings. Select this option to install only the necessary files for defining an additional
PeopleSoft site onto an existing web server configuration. The new site will be accessed using its name in
the URL. For example, a site named "CRM" would be accessed using a URL similar to:

http://mywebserver_machine/CRM

To reset or re-create an existing PeopleSoft site, enter that site's name as the site to create.

1. Select PeopleSoft PIA >PIA Management >Install Additional PeopleSoft Site to access the Install
Additional PeopleSoft Site : Input Screen 1 page.

Note: All the fields are populated with values from the selected PIA target.

2. Click Next to access the Install Additional PeopleSoft Site : Input Screen 2 page.

Image: Install Additional PeopleSoft Site : Input Screen 2 page

This example illustrates the fields and controls on the Install Additional PeopleSoft Site : Input Screen
2. You can find definitions for the fields and controls later on this page

Some of the fields are populated with values. Enter the fields marked *.

App Server Name Enter the host on which the application server domain runs.

Web Profile Password Enter the Web profile password.
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Retype Web Profile Password Re-enter the Web profile password.

Report Repository Location The Process Scheduler report output location.

Integration Gateway Password Enter the Integration Gateway password.

Retype Integration Gateway
Password

Re-enter the Integration Gateway password.

3. On the Install Additional PeopleSoft Site : Credential Screen, select the credentials and then click
Next.

For more information about preferred credential and named credential, see <link>

4. Click OK on the Install Additional PeopleSoft Site : Confirmation Screen.

See the product documentation for PeopleTools Installation for your database platform, "Setting Up the
PeopleSoft Pure Internet Architecture"

Replicate PIA
You can clone the WebServer domains. Replicate PIA creates a destination domain as a replica of source
domain.

1. Select PeopleSoft PIA >PIA Management >Replicate PIA to access the Replicate PIA : Input Screen
page.

Image: Replicate PIA : Input Screen page

This example illustrates the fields and controls on the Replicate PIA : Input Screen page. You can find
definitions for the fields and controls later on this page

Target Domain Name Enter the name of the new PS PIA domain.

Host Select the host server where you intend to install the new
PIA domain.

Web Sever Home Specify the location of your web server product installation.

Web Server Admin User Id Enter the user ID used to signon to the web server
administration console.

Web Server Admin Password Enter the password used to signon to the web server
administration console.
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Report Repository Location Specify the Process Scheduler report output location.

2. Click Next.

3. On the Replicate PIA : Credential Screen, select the credentials and then click Next.

For more information about preferred credential and named credential, see <link>

4. Click OK on the Replicate PIA : Confirmation Screen.

The destination domain will be created with the same properties and websites as that of the source
domain. Edit the configuration of the destination domain to change the http port to proceed with
starting and accessing the PIA URL.

Setup Process Monitor
If you did not add the PS Process Monitor target during the typical discovery process, you can use the
Process Monitor Setup page.

Select PeopleSoft PIA >PIA Management >Setup Process Monitor to access the Process Monitor Setup
page.

Image: Process Monitor Setup page

This example illustrates the fields and controls on the Process Monitor Setup page

 PS PIA Target Select the appropriate PIA installation.

 PROCESSREQUEST WebService
URL

The Process Monitor target accesses the PeopleSoft system
using a WSDL service managed by Integration Broker. Specify
the URL for the WSDL file using the following syntax:

http://<host>:<port>/ PSIGW/
PeopleSoftServiceListeningConnector/<wsdl file name>

For example:

http://pta123.bigcompany.com:10180/PSIGW/
PeopleSoftServiceListeningConnector/PROCESSREQUEST.1.
wsdl

 User ID/Password Enter the PeopleSoft user ID and password that the Process
Monitor will use to access the PeopleSoft system.

Accessing the PeopleSoft Web Site Targets

PS Web Site targets comprise the second part of a PeopleSoft web server. This level contains all of the
PS PIA settings and files; hence, a PS Web Site target requires a tandem PS PIA target in order to be
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activated. There can be one or multiple sites attached to a PS PIA target. The PS Web Site's key role is
configuration.

The PS Web Site homepage shows basic information for a web site. Select Targets > PeopleSoft and
select the desired PS Web Site target. The PS Web Site homepage appears.

Image: PeopleSoft Website page

This example illustrates the fields and controls on the PS Web Site Homepage

Click thePeopleSoft Website link to:

• Monitor the PeopleSoft Website.

See Monitoring

• Control the PeopleSoft Website.

See Control

• View job activity.

See Job Activity

• View information publisher reports.

See Information Publisher Reports

• View performance.

See Performance

• Manage Configuration

Configure Domain

See Configuration Management

• Configure targets.

See Configuration
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• Validate compliance.

See Compliance

• Setup target.

See Target Setup

• View target Information.

See Common Elements on Targets Homepages
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Managing PeopleSoft Process Monitor
Targets

Accessing the PeopleSoft Process Monitor page

The PS Process Monitor homepage enables you to view and access PS Process Monitor information.

Select Targets > PeopleSoft  then select the desired PS Process Monitor target.

Image: PeopleSoft Process Monitor page

This example illustrates the fields and controls on the PS Process Monitor homepage.

Click the PeopleSoft Process Monitor link to:

• Monitor the PeopleSoft Process Monitor.

See Monitoring

• Control the PeopleSoft Process Monitor.

See Control

• View job activity.

See Job Activity.

• View information publisher reports.

See Running the Process Monitor Metrics Report.
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• View performance.

For more information about viewing performance, see Viewing PeopleSoft Process Monitor
Performance.

• Administer PeopleSoft Process Monitor.

See Administering PeopleSoft Process Monitor

• Configure targets.

For more information about configuring targets, see Configuration.

• Validate compliance.

For more information about validating compliance, see Compliance.

• Setup target.

See Target Setup.

• View target Information.

For more information about viewing target information, see Common Elements on Targets
Homepages.

Viewing PeopleSoft Process Monitor Performance

Select Performance to monitor PS Process Monitor performance. The PS Process Monitor performance
page shows these metrics to help you monitor the status of submitted process requests:

Metric Description

Success Count The number of processes completed successfully in the last
hour.

Fail Count The number of processes failed in the last hour. These have a
Run Status of "Error" or "No Success."

Run Count The total number of processes run in the last hour.

Stuck Count The number processes which have been the Run Status of
"Processing" and meets the one of the criteria in the section
below.

Not Posted Count The number of processes with the Distribution Status "Not
posted."

Posting For > 15 Minutes Count The number of processes which have been in the Distribution
Status of "Posting" for more than 15 minutes.

Pending Count The number of processes which have the Run Status of
"Queued" and have a Run Date and Time more than 30
minutes old.

84  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 9 Managing PeopleSoft Process Monitor Targets

Metric Description

Initiated But Pending Count The number of processes which have the Run Status of
"Initiated" and have a Run Date and Time more than 30
minutes old.

Unallocated Count The number of processes which have the Run Status of
"Queued" and have a Run Date and Time more than 30
minutes old and have not been assigned to any server yet.

Stuck Count Criteria
The system retrieves the last 10 succeeded processes that have the same process type.

Last Process Duration Current Process Run duration Tolerance After which to Generate
Alert

For processes which are 1 minute or less. X + 5 minutes Wait for 5 more minutes before
generating the alert.

For processes which are more than 1
minute but less than 60 minutes.

X + 15 min Wait for 15 more minutes before
generating the alert.

For processes which are more than 60
minutes but less than 120 minutes.

X + 20% of previous run time Wait for 20% more minutes before
generating the alert.

For processes which are more than 120
minutes

X + 10% of previous run time Wait for 10% more minutes before
generating the alert.

If there is no similar successful process found, the system generates an alert if it’s in "Processing" for
more than 30 minutes.

Administering PeopleSoft Process Monitor

This section describes how to administer PeopleSoft Process Monitor:

Note: This documentation assumes you have a working knowledge of scheduling processes to run within
PeopleSoft systems.

The Additional Utility link appearing on this page is Execute Host Command.

See Common Elements on Targets Homepages.

Scheduling Process Monitor
PeopleSoft Application management Plug—in for Oracle Enterprise Manager enables you to submit
process requests to be run on the Process Scheduler server, just as you would from the PIA interface. The
same fields and controls you use to submit process requests in PIA are available in the Oracle Enterprise
Manager interface.
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To submit a process request from Oracle Enterprise Manager:

1. Select PeopleSoft Process Monitor >Administration >Schedule Process.

Image: Schedule Process page

This example illustrates the fields and controls on the Schedule Process page.

2. On the Schedule Process page, select all applicable values in the Schedule Info section, such as Run
Control ID, Server Name, and so on.

3. In the Process Info section, select the process to run and any necessary runtime parameters.

a. Click the lookup prompt (flashlight) to open the Select Process Type and Process Name page,
where you select the Process Type, click Go, and select the desired Process Name from the search
results.

b. To set any runtime parameters, click the Set Runtime Parameter button.

4. In the PS Application Credentials section, enter the PeopleSoft user ID and password required to
submit the process.

Note: The default credentials will be those provided during the discovery and setup process.

For more information,

See the product documentation for PeopleTools: Process Scheduler, “Submitting and Scheduling Process
Requests”

See the product documentation for PeopleTools: Process Scheduler, “ Defining PeopleSoft Process
Scheduler Support Information,” Defining Process Definitions

Monitoring Process Monitor
PeopleSoft Application management Plug—in for Oracle Enterprise Manager enables you to monitor
processes that have been submitted to run on the Process Scheduler server by displaying the Process List
and Process Details interfaces. The same fields and controls you use to monitor process requests in PIA
are available in the Oracle Enterprise Manager interface.
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Image: Process Monitor page

This example illustrates the fields and controls on the Process Monitor page.

To monitor processes from Oracle Enterprise Manager:

1. Select PeopleSoft Process Monitor >Administration >Process Monitor.

2. On the Process Monitor page, in the Search Info section, enter the criteria for the processes you want
to monitor, refining the search as needed.

3. In the PS Application Credentials section, enter the PeopleSoft user ID and password required to
access the process list.

Note: The default credentials will be those provided during the discovery and setup process.

4. Click Search.

5. View the processes in the Search Results list.

To view the process details:

1. Locate an individual process in the process list.

2. Click the link in the Instance column.

3. Review process details.

4. (If needed) In the Update Process section, select any applicable options.

5. Click OK.
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Image: Process Detail page

This example illustrates the fields and controls on the Process Detail page.

See the product documentation for  PeopleTools: Process Scheduler, “Monitoring Process Request”.

Running the Process Monitor Metrics Report

You can generate a report that displays a comprehensive view of the Process Monitor predefined metrics.

To generate an All Metrics report:

1. In the Enterprise Manager console and from the Enterprise menu item, select the Reports, Information
Publisher Reports.

2. On the Report Definitions page, click the PeopleSoft Process Monitor - Report for All Metrics report.

You can scroll down the reports list, or you can enter PeopleSoft in the Title search field and click Go.

3. On the Specify Target for Report page, select the Process Monitor target for which to run the report,
and click Continue.

Click the search icon for the PS Process Monitor field and select the appropriate target.

Image: PeopleSoft Process Monitor - Report for All Metrics page

This example illustrates the fields and controls on the Sample PS Process Monitor All Metrics report.
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Managing PeopleSoft Systems and Services

Understanding PeopleSoft Systems

PeopleSoft targets sharing the same application database can be grouped into a PeopleSoft system. A
PeopleSoft system can comprise an application database, multiple PS PIA targets, PS Web Sites, PS
Process Scheduler Domains, PS Process Monitor, PS Search Server Domains, and PS Application Server
Domains. For example, a typical PeopleSoft system might be a production HCM application, which
could include various PeopleSoft entities—like an application server, web server, search server, Process
Scheduler, Process Monitor, and an application database. The PeopleSoft application database is the
common target that binds the other PeopleSoft targets together in the PeopleSoft system.

Note: If you use automated system creation, all PeopleSoft targets that are associated with a particular
PeopleSoft application database are added to this system. Only PeopleSoft targets that have been
registered in Enterprise Manager can be in a system.
PS PIA and PS Web Site targets do not appear in an automatically generated system, unless they have
been logged into previously.

Understanding Services

A service is defined as an entity that provides a useful function to its users; specifically, it models a
business process or application. An administrator defines a service test to determine whether or not the
service is available and performing. A beacon is a target type in Enterprise Manager that performs a
service test.

The PeopleSoft Application Management Plug—in delivers a service test that enables administrators to
monitor the availability of a PeopleSoft application by simulating a login-logout activity.

Note: The delivered service test checks only the login and logout capability of the PeopleSoft application
by simulating it (using the URL entered by the user). However, administrators can create their own
services in Enterprise Manager to track specific areas of their applications, such as in payroll processing
or call center services. They can also modify the generated service.

Creating PeopleSoft Systems

The section discusses:

• The PeopleSoft System homepage.

• Automated PeopleSoft system creation.
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Accessing the PeopleSoft System page
1. Select Targets >Systems.

2. From the Systems page, select a PeopleSoft system.

Image: PeopleSoft System page

This example illustrates the fields and controls on the PeopleSoft System Homepage

Automated PeopleSoft System Creation
To create a PeopleSoft system:

1. Select Targets > Systems.

2. Click the Add >PeopleSoft System to access the Create PeopleSoft System page.

Image: Create PeopleSoft System page

This example illustrates the fields and controls on the Create PeopleSoft System page. You can find
definitions for the fields and controls later on this page
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Automated PeopleSoft System Creation
  PS App DB Select the PeopleSoft database that should be associated to the

new system. The list includes all the PS Application Databases
that have been registered in Enterprise Manager.

  System Name Enter a new system name. Enterprise Manager automatically
assigns a system name as <DBName>+[01-99].PSSystem.
If there is already a system with that name, the new name
increases incrementally by 1. You can change the system name
to one that is more descriptive.

  Timezone Select the appropriate time zone. The default is the time zone of
the Oracle Management Service.

Service Configuration
  Create Service (Optional) Select to configure the service that the PeopleSoft

Application Management plug—in automatically creates for
every valid PeopleSoft system. This service simulates the login-
logout action to the PeopleSoft application.

If you leave the check box cleared, the remaining fields are
unavailable for selection.

  Service Name Enter a service name. The default is <System Name>+. Service.

  Beacon Click the icon to open a browser listing predefined beacons.
 Select the beacon you want associated with the service.

 Timezone Select the appropriate time zone for the service. The default is
the time zone of the Oracle Management Service.

  PS Web Sites and User IDs Lists the PS Web Sites detected in the PeopleSoft system. You
must define the URL for the PeopleSoft page of each PS Web
Site and specify login credentials.

1. Enter the PeopleSoft application homepage URL (the first
page to appear after the PeopleSoft login page). The format
is:

<protocol>://<hostname>/psp/<web site>/<portal>/<node>/
h/<tab ID>

For example:

http://myserver.peoplesoft.com/psp/ps/EMPLOYEE/PT_
LOCAL/h/?tab=DEFAULT

2. Enter a user ID and password for use as the login to these
URLs.

3. To remove a web site from the service, click Delete at the
end of the row.
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Note: A service can be created only if there is at least one
URL and one PS Web Site listed in the Cloud.

Click OK to proceed with the automated system creation.

Note: All system properties are defaulted when the system is created automatically.
There are no defaults for charts and metric data and they must be set up manually, if desired.

Removing PeopleSoft Systems

Removing a PeopleSoft system means you are removing a grouping of targets in Enterprise Manager.
However, you are not removing the targets from the Enterprise Manager or their installations from the
server. The member targets remain in Enterprise Manager and can be managed and used for building other
systems.

To remove a PeopleSoft system:

1. Select Targets > Systems.

2. Select the existing system that you want to remove.

3. Click Remove.

Managing PeopleSoft Systems

This section discusses:

• PeopleSoft system members

• PeopleSoft system URL

• PeopleSoft system topology

PeopleSoft System Members
The PeopleSoft System Members page lists all of the PeopleSoft targets included in the system. You can
click an individual target to display that target's homepage.

1. Select Targets > Systems.

2. Select PeopleSoft System >Members >> Show All
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Image: PeopleSoft System Members page

This example illustrates the fields and controls on the PeopleSoft System Members page.

PeopleSoft System URLs
You can define different system URLs to be accessed in Enterprise Manager. Only users who have full
target privileges can manage PeopleSoft system URLs in Enterprise Manager. To manage PeopleSoft
URLs associated with a system, select the desired PeopleSoft system from the PeopleSoft Home Page and
click the ‘Manage System URLs’ button

Image: Manage System URLs

Manage System URLs page

Note: The system administrator is responsible for populating the correct URL fields. The system does not
verify the URL and by default, the URL fields are blank.

PeopleSoft delivers the following system URL types for you to create and associate URLs to your
PeopleSoft system.

• Process Scheduler Management (targetType is PS Website)

You can enter the URL for any of the submenus used in PeopleTools Process Scheduler. For example,
Process Monitor and Application Engine. Once you have defined this system URL, you can access it
by selecting Administration for the PS Process Scheduler Domain target, then click Manage Process
Scheduler in PIA.

• Web Profile Search (targetType is PS Website)
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This URL is associated with a PS Web Site target. Enter the URL from a PeopleSoft application to
open its web profile page. The naming convention for this URL is <WebSite_Name>+_Web Profile
Search.

• PIA Signon (targetType is PS Website)

You may have multiple values for PIA—however, the PS Web Site is the primary key. The PS Web
Site drop-down list in the Create URL page shows only the PS Web Sites that have been defined in
the PeopleSoft system. If there are no PS Web Sites present in the PeopleSoft system you cannot
create a PIA Signon URL entry. The naming convention for this URL is <WebSite_Name>+_PIA
Signon.

• Integration Broker Monitor Message (targetType is PS Website)

This URL is associated with a PS Web Site target. Enter the URL from a PeopleSoft application to
open its Integration Broker profile page. The naming convention for this URL is <WebSite_Name>
+_Integration Broker Monitor Message.

• Web Server Administration (targetType is PIA)

This refers to WebSphere, Weblogic, or OAS web server administration site. Enter the URL here
to access the web server administration site from Enterprise Manager. You may have multiple
values here, while the PS PIA target is the primary key. The naming convention for this URL is
<PIA_Name>+_Web Server Administration.

These URLS can also be accessed via the Related Links option on the General Pane in their respective
target owners’ page. If no URL has been specified for the URL Type, you will be navigated to the
Manage URLs Page where you can do it.
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Image: Related Links option

Related Links option

Click the PeopleSoft System URL Setup link in the Related Links region of the PeopleSoft System
homepage to access the PeopleSoft System URL page.

Image: PeopleSoft System URL page

This example illustrates the fields and controls on the PeopleSoft System URL page. You can find
definitions for the fields and controls later on this page.

 Edit Select a URL , then click to enter changes to previously created
PeopleSoft system URLs.

 Remove Click to remove a PeopleSoft system URL.

 Create Click to display the Create PeopleSoft System URL page. Select
the URL type and make other appropriate selections. Click
Save.
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Note: By default, the system prepends http:// to the front of the URL, if not already present, when saving
the record.

PeopleSoft System Topology
The Topology page shows a graphical view of a PeopleSoft system and enables you to perform several
tasks.

From the Topology page, you can:

• See the status of each target—icons are green (up), red (down), light gray (unknown), dark gray
(blackout).

• Display data that is refreshed every 30 seconds, or manually if specified.

• Zoom in and out by clicking the icons in the left-hand column. Show summary information on the
number of Incidents and rule violations on a per target or system basis.

To view a PeopleSoft system in the Topology Viewer, On the PeopleSoft target page, Click the target
menu item and then select Members >Topology and select a PeopleSoft system. The homepage appears,
select Topology. The Topology Viewer opens.

Image: PeopleSoft System Topology

This example illustrates the fields and controls on the PeopleSoft System Topology.
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Security for PeopleSoft Application
Management Plug-in

Understanding Enterprise Manager Security

The PeopleSoft Application Management Plug—in relies on Oracle Enterprise Manager's security
framework for most security features.

Enterprise Manager identifies administrators to manage the Enterprise Manager administration accounts.
These are the administrator access categories:

 Administrator This is considered the regular Enterprise Manager administrator.

 Super Administrator This is considered the most powerful Enterprise Manager
administrator with full access privileges to all targets and
administrator accounts within the Enterprise Manager
environment. Only super administrators can perform
administrative operations on regular administrator accounts.

 Repository Owner This is the database administrator for the Management
Repository. This account cannot be modified, duplicated, or
deleted.

From the Enterprise Manager Cloud Control Console, you can create and manage new administrator
accounts. Each administrator account includes its own login credentials, and a set of privileges that are
assigned to the account.

Important! In the current version of the PeopleSoft Application management Plug-in, roles are not
supported. The PeopleSoft AMP only reads the system and target privileges that are added directly to the
user. It does not currently recognize system and target privileges assigned to a user by way of a role. As
such, system and target privileges must be added directly to the user account for managing PeopleSoft
targets.

Working With Target Privileges

Target privileges enable an administrator to perform operations on a target. Certain privileges are
automatically given to administrators based on other privileges. For example, granting any privileges on a
target automatically grants the View target privilege on the host.

Target privileges are divided into these groups:

 View Enables the administrator to view properties, inventory, and
monitor information about a target. The view privilege is
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propagated to all members of aggregate targets such as groups
and systems.

Note: The view privilege must also be assigned to the agent of
the target.

 Operator Enables the administrator to perform the following operations
on a target: startup, shutdown, edit target properties, view the
components of the system, modify system membership, add
charts to the system, create or edit system topology, customize
the dashboard associated with the system, change the columns
that appear on the System Members page, and black out the
system and its components. The Operator Target privilege does
not automatically propagate to members of the System.

 Full Implicitly grants all the target privileges and enables the
administrator to delete a target and configure credentials for
maintenance operations of a target.

When you create a system, you become its owner and
automatically receive full privileges for the system and view
on all targets. Certain privileges are automatically given to
administrators based on other privileges. For example, granting
any privileges on a target automatically grants the View target
privilege on the host.

Related Links
Target Actions and Privileges

Managing Target Preferred Credentials

Target Preferred Credentials is a credential specifically applied to a single target for a particular user.

Preferred credentials simplify access to managed targets by storing target login credentials in the
Management Repository. With preferred credentials set, users can access an Enterprise Manager target
that recognizes those credentials without being prompted to log into the target. Preferred credentials are
set on a per user, per target basis, thus ensuring the security of the managed enterprise environment.

When you create a domain, you are prompted to retain the same credential as the preferred host. You may
choose to enter a new credential.

To manage Enterprise Manager preferred credentials:

1. On the Enterprise Manager Cloud Control page, select Setup, Security, Preferred Credentials.

Enterprise Manager displays the Preferred Credentials page. The first column lists all the target types.

2. Click the Manage Preferred Credentials button.

3. In the Default Credential Section, select a row and then click Set.
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4. In the Select Named Credential dialog box, enter the required parameters and then click Save.

Working With Target Credentials

Each of the target privilege levels are assigned actions that can be performed whenever the privilege is
assigned to a role or user.

See Target Actions and Privileges.

The Target Credentials page is used to verify credentials.

Depending on what actions you want to perform, you may be required to enter host credentials in the
Target Credentials page.

If desired, you can select the Saved Preferred Credentials check box, and the system will not prompt for
credentials the next time you initiate the action for this target (when you are the current user in Enterprise
Manager).

When the user is creating a new target or discovering an existing target, you can choose to select the
preferred credentials or the named credentials. The credential that you select becomes the preferred and
monitoring credential for the discovered or newly created targets.

Image: Preferred Credentials for Target Host

This example illustrates the fields and controls on the Preferred Credentials for Target Host.

Image: Named Credential for Target Host

This example illustrates the fields and controls on the Named Credential for Target Host.

Note: If the preferred credential is already set then you will not be prompted for credential when invoking
administrative actions from the Target Administration tab.
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If the preferred credential is not set for the target, you will be prompted to either select a new credential or
a named credential. The selected credentials is used to run the administrative action on the target.

Image: New Credentials for Target Host

This example illustrates the fields and controls on the New Credentials for Target Host.

Working With Enterprise Manager User Accounts

There are a variety of user accounts that you may use with your Enterprise Manager system. Which
accounts you use and how you manage them with your PeopleSoft system depends on a variety of factors,
including your security implementation and your operating system. Because the topic of user accounts
should be considered at the time of your installation, this topic is discussed in detail within the PeopleSoft
Application Management Plug—in installation documentation that is provided with the plug-in software.

See, Installation Guide: PeopleSoft Application Management Plug—in 13.3.1.1.0 for Oracle Enterprise
Manager 13c.

Updating Target Credentials for PeopleSoft Targets

Target credentials are stored for each PeopleSoft target when it is discovered or created on Enterprise
Manager Cloud Console. The target credentials are stored in $AGENT_HOME\sysman\emd\targets.xml
and used for target metric collection. Due to security restrictions, it is likely that the password will expire
eventually for hosts. If the password expires, metric collection fails for the PeopleSoft targets.

If the password for target credentials expires, one of the following solutions can be used to change the
password for the PeopleSoft targets.

• Remove the target from your system in Enterprise Manager, and rediscover it.

See Understanding the Discovery Process.

• Use the Enterprise Manager Command Line Interface (EM CLI).

EM CLI installation and setup instructions are available at the following local Enterprise Manager Cloud
Console link.

https://<machinename>:<portnumber>/em/console/emcli/download

For example:
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https://st-hp16.peoplesoft.com:7880/em/console/emcli/download

For more information on EM CLI refer to the EM CLI documentation provided by Oracle.

The syntax of the EM CLI command to change the password is:

emcli update_password
-target_type="ttype"
-target_name="tname"
-credential_type="cred_type"
-key_column="column_name:column_value"
-non_key_column="col:oldvalue:newvalue;..."

For example, the following command changes the password for target credentials of an application server
target:

>emcli update_password
-target_type=ps_app_server
-target_name=newapp1.app.st-hpp03.ds1_home_psoft_psft_pt_853-809-I1
-credential_type=PsoftHostCreds
-key_column="HOST_USERNAME:psoft"
-non_key_column="HOST_PASSWORD:psoft456:psoft"

Similarly, the password can be changed for other PeopleSoft target types. Change the target name, type,
username and password in the above command for other PeopleSoft targets.

Target target_type Value

PS Application Server Domain ps_app_server

PS Process Scheduler Domain ps_process_scheduler

PS Search Server Domain ps_search_server

PS PIA ps_pia

PS Website ps_web_site

PS Process Monitor ps_process_monitor

PS Application Database ps_app_db

Note: To change the password for multiple targets, the change password commands for multiple targets
can be stored in a script and run once to update multiple passwords.
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Validating Rules

Understanding Compliance for PeopleSoft Application
Management Plug-in

The Oracle Environment Management Compliance Management solution provides the capability to
define, customize, and manage Compliance Frameworks and Compliance Standards. It also provides
the tools to evaluate targets and systems for compliance with business best practices in terms of
configuration, security, storage, and so on.

The compliance solution

• Automatically determines if targets and systems have valid configuration settings.

• Automatically determines if targets and systems are exposed to configuration-related vulnerabilities.

• Advises how to change configuration to bring targets and systems into compliance with respect to best
practices.

• Provides real-time monitoring of a target’s files, process, users, Windows registry entries, and more to
let EM users know where configuration change is taking place in their environment.

• Determines if real-time detected configuration changes were authorized by open change management
requests. Violations are created when an action is determined to be unauthorized.

• Provides out-of-box Compliance Frameworks (PCI, CIS, for example) and compliance standards
to map to Compliance Standard Rules. This mapping makes it possible to visualize how out of
compliance settings and actions will affect any compliance framework an organization follows.

Compliance Feature Overview

Compliance Framework A compliance framework is an industry-specified best practices
guideline that deals with the underlying IT infrastructure,
 applications, business services and processes, and how they are
organized, managed and monitored.

Compliance Standard Compliance Standard is EM’s representation of a compliance
control that must be tested against some set of IT infrastructure
to determine if the control is being followed. Compliance
standards can be mapped to Compliance Frameworks so that
violations can result in a compliance score impact on the
Compliance Framework.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved. 103



Validating Rules Chapter 12

Compliance Standard Rule Compliance standard rules specify the actual check that is going
to happen. These rules are mapped to one or more Compliance
Standard.

Image: Compliance Standards

This example illustrates the fields and controls on the Compliance Standards tab.

Image: Compliance Standard Rules

This example illustrates the fields and controls on the Compliance Standard Rules.

Associating Compliance Standard to a PeopleSoft Target
When you deploy PeopleSoft AMP on OMS, the PeopleSoft compliance entities like rules, standards ,
standard group, and the framework appear in the compliance library. To view these entities, select
Enterprise, Compliance, Library.

Compliance rules are available to PS Application Server, PS PIA, and PS WebSite targets only. After
a compliance standard is available for a target type, you must manually associated each target to a
PeopleSoft target to generate violation.

1. Select Enterprise, Compliance, Library.

2. Click the Compliance Standard tab.

3. Search and select the standards for PeopleSoft target.

4. Click the Associate Targets button.

5. Click Add.
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6. Select the target and then click OK.

Viewing the Violation Message
1. Select Enterprise >Compliance >Results.

2. Click Standard and then click Show Details.

Image: Compliance Standard Result Details

This example illustrates the fields and controls on the Compliance Standard Result Details.
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Configuration and Metric Data Collected

Configuration Data Collected

Enterprise Manager collects configuration data from each target type's configuration. Configuration data
is collected on a regular basis—the default is once a day—and is transmitted to the Oracle Management
Service. The first configuration collection occurs after the initial discovery process.

For subsequent configuration collections, the Oracle Management Service receives and parses the data
and saves updates to the Management Repository. In addition to the regularly scheduled configuration
collection process, collections are triggered every time you change a target's configuration from within
Enterprise Manager.

PeopleSoft Target Type Data in These Files

PS Application Database PeopleTools tables

PS Application Server Domain psappsrv.cfg, psappsrv.ubx

PS Process Scheduler Domain psprcs.cfg, psprcs.ubx

PS Search Server Domain pssrchsvr.cfg, pssrchsvr.ubx

PS PIA piaInstallLog.xml, config_prop, setEnv.sh/cmd or opmn.xml
or server.xml

PS Web Site web.xml, configuration.properties, integrationGateway.
properties, pstools.properties, config_prop

PS Process Monitor For the PS Process Monitor target configuration, only the
PeopleTools version and the WSDL URL is collected as part
of configuration metrics. These two properties are collected
from the PS Process Monitor target properties that are stored
in $AGENT_HOME/sysman/emd/targets.xml.

Metric Data Collected

Metric data refers to the collection of data that changes frequently, such as status, memory, disk
utilization, and so on. PeopleSoft delivers predefined metric types and default collection times for each
target type. The metrics can be viewed by clicking the All Metrics link on each target homepage.

The metric data collected is saved to the Management Repository and is compared to predefined
thresholds for each target. If a threshold has been reached, the system generates an alert. The Incidents
display on each target's homepage.
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Target Type Attribute Name Collection Schedule Description

PS Application Database Availability/Response 10 minutes Checks the status of the PS
Application Database

PS Application Server
Domain

Availability/Response 1 minute Checks the status of PS
Application Server Domain

PS Application Server
Domain

# of Process Queued for App
Server

10 minutes Monitors the number of
PSAPPSRV processes queued
for a PS Application Server
Domain. Generates an alert
if the defined threshold is
reached.

PS Application Server
Domain

# of Process Queued for BRK
Dispatcher (if enabled)

13 minutes Monitors the number of
PSBRKDSP processes queued
for a PS Application Server
Domain. Generates an alert
if the defined threshold is
reached.

PS Application Server
Domain

# of Process Queued for BRK
Handler (if enabled)

14 minutes Monitors the number of
PSBRKHND processes
queued for a PS Application
Server Domain. Generates an
alert if the defined threshold is
reached.

PS Application Server
Domain

# of Process Queued for PUB
Dispatcher (if enabled)

12 minutes Monitors the number of
PSPUBDSP processes queued
for a PS Application Server
Domain. Generates an alert
if the defined threshold is
reached.

PS Application Server
Domain

# of Process Queued for PUB
Handler (if enabled)

15 minutes Monitors the number of
PSPUBHND processes
queued for a PS Application
Server Domain. Generates an
alert if the defined threshold is
reached.

PS Application Server
Domain

# of Process Queued for SUB
Dispatcher (if enabled)

16 minutes Monitors the number of
PSSUBDSP processes queued
for a PS Application Server
Domain. Generates an alert
if the defined threshold is
reached.

PS Application Server
Domain

# of Process Queued for SUB
Handler (if enabled)

17 minutes Monitors the number of
PSSUBHND processes
queued for a PS Application
Server Domain. Generates an
alert if the defined threshold is
reached.
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Target Type Attribute Name Collection Schedule Description

PS Application Server
Domain

PSAPPSRV Handler Count 5 minutes Monitors the number of
active PSAPPSRV processes.
 Generates Incidents if the
count is above the specified
value.

PS Application Server
Domain

Total Tuxedo Connections 5 minutes Counts the number of
Tuxedo connections to the PS
Application Server Domain.
 Generates Incidents if the
count is above the specified
value.

PS Application Server
Domain

Failed Processes 5 minutes Shows the number of server
processes that are down
within a domain. The domain
configuration should be
verified against the server
status. It generates Incidents
if the failed processes count is
greater than or equal to 1.

PS Application Server
Domain

JSH Aborts 5 minutes Shows the number of
application server domain
JSH Aborts. If the value
exceeds the threshold, the
system logs and alert.

PS Application Server
Domain

JSH Load 5 minutes The number of JSHs loaded.
 Formula for this count is:

(Sum of Bgn values for JSH
handlers in the client status) - 
(Sum of Cmmt values for JSH
handlers in the client status).

If the value exceeds the
threshold, the system logs an
alert.

PS Application Server
Domain

WSH Aborts 5 minutes Shows the number of PS
Application Server Domain
WSH Aborts. If the value
exceeds the threshold, the
system logs and alert.

PS Application Server
Domain

WSH Loads 5 minutes The number of WSHs loaded.
 Formula for this count is:

(Sum of Bgn values for WSH
handlers in the client status)
- (Sum of Cmmt values for
WSH handlers in the client
status).

If the value exceeds the
threshold, the system logs and
alert.
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Target Type Attribute Name Collection Schedule Description

PS Application Server
Domain

PS Application Server Client/
Queue Server/Status

Real time Displays the status of the
client, queue, and server
elements of the domain. This
is equivalent to using the
Domain Status menu options
in PSADMIN.

PS Application Server
Domain

Long Running Service
Request Count

1 hour Monitors the number of
Service Requests that are
long running (more than 10
secs). Generates alerts with
multiple severity levels if this
count exceeds pre-defined
thresholds

PS Application Server
Domain

Memory Usage 1 hour Monitors the memory
footprint used by App Server
processes. Generates alerts
when it exceeds the pre-
defined threshold.

PS Application Server
Domain

Tuxedo File Count 1 day Monitors the number of
tuxedo files created in
temporary directory. This
is an indicator of Tuxedo
memory queue size. Generates
alerts when it exceeds the pre-
defined threshold.

PS Application Server
Domain

Memory Usage Growth 15 minutes Monitors the memory
footprint growth pattern of
the App Server. Generates
alerts with multiple levels
of severity if the number
of spikes in memory usage
growth exceeds pre-defined
thresholds

PS Application Server
Domain

PeopleTools State Files Count 1 hour Monitors the number of
PeopleTools State files
generated in the domain logs
directory. Generates alerts
if the count exceeds a pre-
defined threshold.

PS Application Server
Domain

Tuxedo Service Error Count 1 hour Monitors the number of
Tuxedo Service errors in
the App Server log files.
 Generates alerts with multiple
levels of severity if the
count exceeds pre-defined
thresholds.

PS Application Server
Domain

Paging Count 15 minutes Monitors the paging activity
on the AppServer. Generates
alerts if the paging is
happening very frequently.
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Target Type Attribute Name Collection Schedule Description

PS Application Server
Domain

App Server Queues Wait
Count

15 minutes Monitors the count of App
Server Queues experiencing
wait times. Generates alerts
with multiple levels of
severity if the count exceeds
pre-defined thresholds.

PS Application Server
Domain

IB Queue Flowing 15 minutes Monitors the movement of the
IB Queue. Generates alert if it
is stuck.

PS Application Server
Domain

Heavy Transaction Activity 15 minutes Monitors heavy transaction
activity to file system.
 Generates alert if the heavy
activity persists for more than
a pre-defined period of time.

PS Application Server
Domain

App Server Restart Error
Count

15 minutes Monitors if there are App
Server restart related errors in
the log files. Generates alerts
if there are any such restart
errors in the logs.

PS Application Server
Domain

Low Disk Space 1 day Monitors the disk space in the
host on which the database,
 App Server or PIA targets
exists is running.Generate
alert if the disk space is low.

PS Application Server
Domain

Archive TraceSql Files 1 day Monitors the TraceSql files
that are huge or old that
requires archiving. Generates
alerts if such files exist.

PS Application Server
Domain

Archive Old Log Files 1 day Monitors existing old log
files that is to be archived.
 Generates alerts if such files
exist.

PS Application Server
Domain

Highly Frequent GC Count 1 hour Monitors the number of
highly frequent (within 15
seconds apart) Garbage
Collections that are occurring
in Web Servers. Generates
alerts with multiple severity
levels if this count exceeds the
pre-defined thresholds.

PS Application Database
Domain

Low Disk Space 1 day Monitors the disk space in the
host on which the database,
 App Server or PIA targets
exists is running.Generate
alert if the disk space is low.

PS Process Scheduler Domain Availability/Response 1 minutes Checks the status of PS
Process Scheduler Domain.
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Target Type Attribute Name Collection Schedule Description

PS Process Scheduler Domain # Queued Processes
for Process Scheduler 
(PSPRCSRV)

15 minutes Monitors the number of
PSPRCSRV processes queued
for a PS Process Scheduler
Domain. Generates an alert if
the defined threshold has been
reached.

PS Process Scheduler Domain # Queued Processes
for Distribution Server 
(PSDSTSRV)

15 minutes Monitors the number of
PSDSTSRV processes queued
for a PS Process Scheduler
Domain. Generates an alert if
the defined threshold has been
reached.

PS Process Scheduler Domain Failed Processes 5 minutes Displays the current number
of failed or down server
processes within the domain.
 It generates Incidents if the
failed processes count is
greater than or equal to 1.

PS Process Scheduler Domain PS Server Queue/Server
Status

Real time Displays the status of the
queue and server elements of
the domain. This is equivalent
to using the Domain Status
menu options in PSADMIN.

PS Process Scheduler PS Process Scheduler Log
Monitor

5 Minutes This metric contains the
details of the limit on the
number of sub folders inside
the Peoplesoft Process
Scheduler Log Location .An
alert message is generated
if the number of sub folders
exceeds the os_limit.

PS PIA Availability/Response 1 minute Checks the status of PS PIA.

PS PIA Highly Frequent GC Count 1 hour Monitors the number of
highly frequent (within 15
seconds apart) Garbage
Collections that are occurring
in Web Servers. Generates
alerts with multiple severity
levels if this count exceeds the
pre-defined thresholds.

PS PIA Fatal Error Count 1 hour Monitors the number of fatal
errors in the servlet logs.
 Generates alerts with multiple
severity levels if this count
exceeds the pre-defined
thresholds.
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Target Type Attribute Name Collection Schedule Description

PS PIA WAIT State Socket Count 1 hour Monitors the number of Web
Server Sockets that are in
WAIT State. Generates alerts
with multiple severity levels
if this count exceeds the pre-
defined thresholds.

PS PIA GC Frequency 15 minutes Monitors the frequency with
which garbage collection
happens in the Web Server.
 Generates alerts with
multiple levels of severity
if the frequency of garbage
collection exceeds pre-defined
thresholds.

PS PIA Web Profile Load Error Count 1 hour Monitors the number of Web
Profile Load errors in the Web
Server log. Generates alert if
the error count exceeds pre-
defined threshold.

PS PIA Low Disk Space 1 day Monitors the disk space in the
host on which the database,
 App Server or PIA targets
exists is running.Generate
alert if the disk space is low.

PS Web Site Availability/Response 1 minute Checks the status of PS PIA
where the PS Web Site is
connected.

PS WebSite PS FTP Log Monitor 5 Minutes This metric contains the
details of the limit on the
number of sub folders inside
the Peoplesoft PIA FTP
Location .An alert message is
generated if the number of sub
folders exceeds the os_limit.s

PS WebSite PS Reports Monitor 5 Minutes This metric contains the
details of the limit on the
number of sub folders inside
the Peoplesoft PIA Report
Repository Location .An alert
message is generated if the
number of sub folders exceeds
the os_limit.s.

PS WebSite Report Repository Size 1 day This is also called PS Reports
Monitor in PeopleSoft plug-
in.

PS Search Server Domain Availability/Response 1 minute Checks the status of the PS
Search Server Domain.
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Target Type Attribute Name Collection Schedule Description

PS Search Server Domain # Queued Processes for
Search Server (PSSRCHSRV)

5 minutes Monitors the number of
PSSRCHSRV processes
queued for a PS Search Server
Domain. Generates an alert if
the defined threshold has been
reached.

PS Search Server Domain PS Search Server Client/
Queue/Server Status

Real time Displays the status of the
client, queue, and server
elements of the domain. This
is equivalent to using the
Domain Status menu options
in PSADMIN.

PS Process Monitor Availability/Response 1 minute Checks the status of the PS
Process Monitor.

PS Process Monitor # of Running PeopleSoft
Processes

30 minutes Monitors the count of running
processes (Run Status =
Processing) in the last 1 hour.

PS Process Monitor # of Successful PeopleSoft
Processes

30 minutes Monitors the count of
successfully completed
processes (Run Status =
Success) in the last 1 hour.

PS Process Monitor Failed count 30 minutes Displays the failed process
count using Reporting web
service. Run Status include
"Error" and "No Success.
" Generates Incidents if
the metric value exceeds
threshold value.

PS Process Monitor Not Posted count 30 minutes Displays the process count of
those not posted. Distribution
Status is "Not posted.
" Generates Incidents if
the metric value exceeds
threshold value.

PS Process Monitor Processes posted for more
than 15 minutes

30 minutes Displays the processes
count for processes in the
posting state for more than 15
minutes. Generates Incidents
if the metric value exceeds
threshold value.

PS Process Monitor Batch Processes stuck count 30 minutes Checks the processes which
are stuck. Run Status would
be "Processing" for more
than 30 minutes. Generates
Incidents if the metric value
exceeds threshold value.

114  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 13 Configuration and Metric Data Collected

Target Type Attribute Name Collection Schedule Description

PS Process Monitor Pending processes count 30 minutes Checks the processes which
are pending. Run Status
would be "Queued" for
greater than or equal to 30
minutes. Generates Incidents
if the metric value exceeds
threshold value.

PS Process Monitor Initiated but pending
processes count

30 minutes Checks the processes which
are initiated but pending. Run
Status should be "Initiated"
for greater than or equal to 30
minutes. Generates Incidents
if the metric value exceeds
threshold value.

PS Process Monitor Failed PS Process Metrics
Data

Real time Displays the failed processes
using Reporting web service.
 Run Status include "Error"
and "No Success."

PS Process Monitor Initiated But Pending PS
Process Metrics Data

Real time Displays the processes which
are initiated but pending. Run
Status should be "Initiated"
for greater than or equal to 30
minutes.

PS Process Monitor Not Posted PS Process
Metrics Data

Real time Displays the processes that are
not posted. Distribution Status
is "Not posted."

PS Process Monitor Pending Process Metrics Data Real time Displays the processes which
are pending. Run Status
would be "Queued" for
greater than or equal to 30
minutes.

PS Process Monitor Posting For More Than 15
Minutes Process Metrics Data

Real time Displays the processes that are
in the posting state for more
than 15 minutes.

PS Process Monitor Stuck PS Process Metrics
Data

Real time Displays the processes which
are stuck. Run Status would
be "Processing" for more than
30 minutes.

PS Process Monitor Unallocated Real Time The number of processes
which have the Run Status
of "Queued" and have a Run
Date and Time more than 30
minutes old and have not been
assigned to any server yet.
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Target Type Attribute Name Collection Schedule Description

PS Process Monitor PS Process Scheduler
Suspended Status

5 Minutes This metric contains the
details of the Process
Scheduler domains that are
active but not responding.
 The Process Monitor is used
for determining the hang
status of the process scheduler
domains. The collection
interval is 5 minutes. This
metric would determine the
number of servers in the
hang state and appropriately
display the alert message as
"The server(s) is(are) not
responding".

To activate the metrics establish the JMX connection. In the psappsrv.cfg file, scroll to the PSTOOLS
section to update the following:

• Enable Remote Administration = 1

• Enter admin as the remote administration User ID.

• Enter {V1.1}7m4OtVwXFNyLc1j6pZG69Q== as the remote administration password.

Note: Enter the password either in plain text or encrypt using PSCipher

Note: The AppServer Minimum Process Count Value is implemented as a compliance rule that is
applicable to PS Application server . A violation is generated if the Appserver’s minimum process count
value is less than 5.

Note: WAIT State Socket Count, GC Frequency, Fatal Error Count are not applicable to WebSphere
domain.
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Working with Privileges

Target Actions and Privileges

Important! In the current version of the PeopleSoft Application management Plug-in, roles are not
supported. The PeopleSoft AMP only reads the system and target privileges that are added directly to the
user. It does not currently recognize system and target privileges assigned to a user by way of a role. As
such, system and target privileges must be added directly to the user account for managing PeopleSoft
targets.

The following table lists target actions for each of the target types and actions for systems and logs.

Note: Users assigned a super administrator role can perform all actions for all target types, systems, and
logs.

Target Actions and Privileges Tables
This section includes tables showing target actions, credentials, and privileges.

PS Application Server Domain

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Create domain Yes Yes, with target system
privileges

Configure domain Yes Yes

Import domain
configuration from file

Yes Yes, with target system
privileges

Create like domain Yes Yes, with target system
privileges

Compare to multiple
configurations (jobs)

Yes

Last collected
configuration

Yes

View saved
configuration

Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

History Yes

Copy configurations Yes Yes

Create service 
(Windows only)

Yes Yes

Create messaging
server

Yes Yes

Configure messaging
server

Yes Yes

Delete messaging
server

Yes Yes

Create service 
(Windows only)

Yes Yes

Configure service 
(Windows only)

Yes Yes

Install service 
(Windows only)

Yes Yes

Delete service 
(Windows only)

Yes Yes

Start domain (parallel
and serial)

Yes Yes Yes

Stop domain (forced
and normal)

Yes Yes Yes

Access Tuxedo
command line 
(TMADMIN)

Yes Yes Yes

Purge/archive cache Yes Yes Yes

View domain processes
status

Yes Yes Yes

View domain queue
status

Yes Yes Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

View domain client
status

Yes Yes Yes

Delete domain Yes Yes

Preload file cache Yes Yes Yes

Clean IPC resources Yes Yes Yes

Execute host command Yes Yes Yes

View domain status 
(stopped or running)

Yes Yes Yes

PS Search Server Domain

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Create domain Yes Yes, with target system
privileges

Configure domain Yes Yes

Compare to multiple
configurations (Job)

Yes

Last collected
configuration

Yes

View saved
configuration

Yes

History Yes

Start domain Yes Yes Yes

Stop domain (forced
and normal)

Yes Yes Yes

Delete domain Yes Yes

Clean IPC resources Yes Yes Yes

Access Tuxedo
command line 
(TMADMIN)

Yes Yes Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Create service 
(Windows only)

Yes Yes

Configure service 
(Windows only)

Yes Yes

Install service 
(Windows only)

Yes Yes

Delete service 
(Windows only)

Yes Yes

View domain processes
status

Yes Yes Yes

View domain queue
status

Yes Yes Yes

View domain client
status

Yes Yes Yes

View domain status 
(stopped or running)

Yes Yes Yes

Execute host command Yes Yes Yes

PS Process Scheduler Domain

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Create domain Yes Yes, with target system
privileges

Configure domain Yes Yes

Import domain
configuration from file

Yes Yes, with target system
privileges

Create like domain Yes Yes, with target system
privileges

Compare to multiple
configurations (Job)

Yes

Last collected
configuration

Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

View saved
configuration

Yes

History Yes

Copy configurations Yes Yes

Create service 
(Windows only)

Yes Yes

Configure service 
(Windows only)

Yes Yes

Install service 
(Windows only)

Yes Yes

Delete service 
(Windows only)

Yes Yes

Start domain Yes Yes Yes

Stop domain (forced
and normal)

Yes Yes Yes

Delete domain Yes Yes

Clean IPC resources Yes Yes Yes

View domain processes
status

Yes Yes Yes

View domain queue
status

Yes Yes Yes

View domain status 
(stopped or running)

Yes Yes Yes

Execute host command Yes Yes Yes

Manage Process
Scheduler in PIA

Yes, also prompted for
PIA login

Yes Yes
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PS PIA

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Edit setEnv Yes Yes

Edit web.xml Yes Yes

Compare to multiple
configurations

Yes

Last collected
configuration

Yes

View saved
configuration

Yes

History Yes

Start PIA Yes Yes Yes

Stop PIA Yes Yes Yes

Web server type
administration console

Yes, also prompted for
PIA login

Yes Yes Yes

Customize start/stop
scripts

Yes

Execute host command Yes Yes Yes

View web domain
status (if stopped or
running)

Yes Yes Yes

Process Monitor Setup Yes Yes, with target system
privileges

PS Process Monitor

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Compare domain
configurations

Yes

Compare to multiple
configurations

Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Last collected
configuration

Yes

View saved
configuration

Yes

History Yes

Execute host command Yes Yes Yes

Process Monitor Yes Yes Yes

Schedule Process Yes Yes Yes

View predefined
process metrics

No Yes Yes Yes

PS Web Site

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Configure site Yes Yes

Web profile Yes, also prompted for
PIA login

Yes Yes

Integration Broker Yes, also prompted for
PIA login

Yes Yes

Compare
configurations

Yes

Compare to multiple
configurations (jobs)

Yes

Last collected
configuration

Yes

View saved
configuration

Yes

History Yes

PIA signon Yes, also prompted for
PIA login

Yes Yes Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

View web site status Yes Yes Yes

PS Application Database

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

View status Yes Yes Yes

Log Management (All Targets Except PS Web Site, PS Process Monitor, and PS
Application DB)

Target Actions Target Credentials
Required

Full Role Operator Role Viewer Role

Search logs Yes Yes Yes Yes

View logs Yes Yes Yes Yes

Purge logs Yes Yes Yes

Log management setup Yes

Management Actions

Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Create PeopleSoft
system (only super
administrator)

Edit PeopleSoft system Yes, if target access
granted

Yes, if target access
granted

Delete PeopleSoft
system

Yes, with target system
privileges

View PeopleSoft
system

Yes, if target access
granted

Yes, if target access
granted

Yes, if target access
granted

Add PeopleSoft URL Yes

Delete PeopleSoft URL Yes
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Target Actions Target Credentials
Required

Full Privilege Operator Privilege Viewer Privilege

Edit PeopleSoft URL Yes

Access PeopleSoft
system URLs

Yes Yes Yes

Add PeopleSoft targets 
(super administrator)

Remove target Yes, with target system
privileges

Start/Stop multiple
domains (from
PeopleSoft targets
page)

Yes Yes Yes
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Target Log Files

Default Target Log Files

This section lists default log file locations and types for:

• PS PIA targets.

• PS Application Server Domains.

• PS Search Server Domains.

• PS Process Scheduler Domains.

PS PIA Log Files
File Location Log File Type

If using Weblogic: <PIA_HOME>/webserv/<Domain>/
applications/peoplesoft/PSEMHUB/envmetadata/logs

If using WebSphere: <PIA_HOME>/webserv/<cellname>
_<nodename>_<servername>/peoplesoft.ear/PSEMHUB/
envmetadata/logs

*.txt

<PIA_HOME>/webserv/<Domain>/logs *.log

<PIA_HOME>/webserv/<Domain>/logs/replaydump *.bug

<OAS_HOME>/j2ee/<Domain>/log/<Domain>_default_
island_1/

*.log

<WEBSPHERE_HOME>/logs/<server_name> *.log

<WEBSPHERE_HOME>/logs *.log
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PS Application Server Domain Log Files
File Location Log File Type

<PS_CFG_HOME>/appserv/<appserver_domain>/LOGS *.LOG

TUXLOG.*

*.trc

*.tracesql

*.mps

*.lp

process_state*

*.dmp

peopletools_state*

<PS_CFG_HOME>/appserv/<appserver_domain> ULOG.<date>

stderr

stdout

<PS_CFG_HOME>/appserv core

PS Search Server Domain Log Files
File Location Log File Type

<PS_CFG_HOME>/appserv/search/DOMAIN_NAME/LOGS *.trc

*.LOG

*.log

*.lp

*.dmp

process_state*

peopletools_state*

<PS_CFG_HOME>/appserv/search/DOMAIN_NAME stdout

stderr

ULOG*

<PS_CFG_HOME>/appserv core
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PS Process Scheduler Server Log Files
File Location Log File Type

<PS_CFG_HOME>/appserv/ core

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>/ stderr

stdout

ULOG*

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>/LOGS/ *.LOG

process_state*

peopletools_state*

TUXLOG*

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>/log_output/ delete_*.txt

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>/log_output/
_PSPRCSRVLOG/

*.*

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>/log_output/
_PSDSTSRVLOG

*.*

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>/log_output/
_TUXLOG/

*.*

<PS_CFG_HOME>/appserv/prcs/<prcs_domain>files/ *.*
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Target Rules

PS Application Server Domain Rules

Rule Definition Severity

Client Cleanup Timeout The value should be <= 20 minutes. If
it is greater than 20, a violation should
be called out. Setting the value to 20
or less avoids having many idle client
connections connected to the host. With
client cleanup time out at a minimum
value, it is a more effective use of the
server’s memory and CPU and improves
performance.

Warning

PSAPPSRV Recycle Count Value should be >= 5000. Setting this
at zero or too low may cause memory
swapping.

Warning

Enable Server Caching Recommend a setting of 2 to minimize
the cost of recycling the application
servers.

Informational

PSQRYSRV Min Handler Set this to 1 if the PUBSUB server for
the domain was activated.

Informational

PSBRKDSP Allowed Consec Service
Failures

Set to > 1 to enable the system to recycle
on its own in an event of a service
failure.

Informational

PSPUBDSP Allowed Consec Service
Failures

Set to > 1 to enable the system to recycle
on its own in an event of a service
failure.

Informational

PSSUBDSP Allowed Consec Service
Failures

Set to > 1 to enable the system to recycle
on its own in an event of a service
failure.

Informational

PSBRKHND Allowed Consec Service
Failures

Set to > 1 to enable the system to recycle
on its own in an event of a service
failure.

Informational

PSPUBHND Allowed Consec Service
Failures

Set to > 1 to enable the system to recycle
on its own in an event of a service
failure.

Informational

PSSUBHND Allowed Consec Service
Failures

Set to > 1 to enable the system to recycle
on its own in an event of a service
failure.

Informational
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PS PIA Rule

Rule Definition Severity Configuration File

JVM Heap size Minimum and maximum heap
size should be set to equal and
it should be >= 256MB

Warning SetEnv/opmn.xml/server.xml

PS Web Site Rules

Rule Definition Severity Configuration File

Ig.isc.serverURL The application server and
WSL port combination
should relate to a valid
application server domain
whose PUBSUB feature is set
to active or true.

Warning IntegrationGateway.properties

Ig.isc.toolsRel The PeopleTools version
specified should be equal to
the PeopleTools version of the
web server domain up to the
patch level.

Warning IntegrationGateway.properties

Compress Responses Should be activated or set to
true to enable faster transfer
of transactional messages
across the network.

Informational Web Profile

Compress Response
Reference

Should be activated or
set to true to activate the
compression from the web
server to browser.

Informational Web Profile

Cache Portal Objects Should be activated to
improve system performance
by reducing service requests
from the web server to the
application server.

Informational Web Profile

Cache Proxied Javascripts These should be set to true for
improved performance.

Informational Web Profile

Cache Target Contents These should be set to true for
improved performance.

Informational Web Profile

Cache homepage These should be set to true for
improved performance.

Informational Web Profile

Cache Generated HTML These should be set to true for
improved performance.

Informational Web Profile
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Rule Definition Severity Configuration File

METAXP Should be equal to Cache
Stale Interval. Cache Stale
Interval value is seconds
while METAXP is in
minutes. So there should be
a conversion that happens to
detect a violation.

Warning PeopleTools, Personalization,
 Personalization Options.
 Option Category Level =
PPTL
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Target Relationships

Links That Display on Homepages

Link Displayed Where What It Means

PS Application Database Homepage of PS Application Server, PS
Process Scheduler, PS Search Server

Successful discovery of the PS
Application Database to which the target
is connected.

PS Search Server PS Application Server homepage Valid entry in the Remote Search Server
Credentials field (Search Section) in an
application server domain configuration 
(psappsrv.cfg file that includes the
domain ID, its fully qualified host name,
 and the search server port.

PeopleSoft System Homepage of all targets The target is an element of a PeopleSoft
system.

Messaging Server PS Application Server page Domain was created using a template 
(small, medium, large or custom) with
these default sections of PUBSUB:
PSBRKDSP_dflt, PSBRKHND_dlft,
 PSSUBDSP_dlft, PSSUBHND_dlft,
 PSPUBDSP_dlft, PSPUBHND_dlft

Windows Services Management PS Application Server page, PS Process
Scheduler page, and PS Search Server
page

Host operating system is Windows

Manage Process Scheduler in PIA PS Process Scheduler page PS Process Scheduler Domain is an
element in a PeopleSoft system and has a
URL defined for it.

PS Application Server PS Search Server homepage PS Search Server Domain PSSRCHSRV
section of configuration data has a
valid entry for the application server
credentials. The entry includes the
domain ID, fully qualified host name and
application server port (same value as the
search server port).

Web Sites PS PIA homepage Successful discovery of PS Web Site,
 contained in this PS PIA target.

PS PIA PS Web Site homepage

PS Process Monitor homepage

Successful discovery of PS PIA in which
the web site is contained.
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Link Displayed Where What It Means

PS Process Monitor PS PIA homepage Successful setup of Process Monitor with
PS PIA.

PROCESSREQUEST WebService URL PS Process Monitor homepage Location of web service definition file
configured using PeopleSoft Integration
Broker. Process Monitor uses this
web service to schedule and monitor
PeopleSoft processes.

Reverse Proxy PS PIA homepage Yes value means the target is connected
to a reverse proxy server.

N/A value means the target is not
connected to a reverse proxy server.

Reverse proxy server data comes from
the web profile's Virtual Addressing
page.

Web Server Console PS PIA page PS PIA is an element in a PeopleSoft
system and has a Web Server
Administration URL defined for it.

Web Profile PS Web Site page . PS Web Site is an element of a
PeopleSoft system and has a Web Profile
URL defined for it.

Integration Broker PS Web Site page PS Web Site is an element of a
PeopleSoft system and has a Integration
Broker URL defined for it.

PIA Signon PS Web Site page PS Web Site is an element of a
PeopleSoft system and has a PIA Signon
URL defined for it.

Relationships on Topology Page

Topology Page Relationships Established How

PS PIA and PS Web Site Defined by a discovery search on web server directories and
paths.

PS Web Site and PS Application Server Depends on the psserver value in the PS Web Site's
configuration.properties file. Valid entry is the application
server’s fully qualified host name and its Jolt port.

PS Application Server and PS Search Server Depends on the remote search server credentials value in the
application server domain's configuration (psappsrv.cfg) file.
 Valid entry includes the search server's domain ID, its fully
qualified host name and the search server port.
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Topology Page Relationships Established How

PS Application Server and PS Application Database

PS Process Scheduler and PS Application Database

PS Search Server and PS Application Database

Defined by the database GUID, which is generated when an
application server connects to the database the first time.

PS Process Monitor and PS PIA Defined by user during Discovery or Process Monitor Setup.
 Process Monitor can be registered in repository with pre-
discovered PS PIA target.

Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved. 137



Target Relationships Chapter 17

138  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 18

Troubleshooting

PeopleSoft AMP Agent Logs

PeopleSoft AMP Issues on Management Agent
The log files are located in the USER_HOME directory for each host.

To debug PSFT plugin issues on Management Agent, navigate to the log files for the host here,
USER_HOME/psft/pt/emplugin/logs.

PeopleSoft AMP on Enterprise Manager 13c on Oracle Management Service
Navigate to MW_HOME/gc_inst/em/EMGC_OMS1/sysman/log ‐ emoms.trc & emoms.log.

Enable DEBUG Logging on Oracle Management Service
Run the emctl command, OMS_HOME/bin/emctl set property ‐name
log4j.rootCategory ‐value "DEBUG, emlogAppender, emtrcAppender" ‐module
logging.

Enable DEBUG Logging on Management Agent
Navigate to AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/
config/psemagentlogging.properties to enable debug logging.

To enable diagnostic logging feature, enable diagnostic logger Read more about enabling diagnostic
logging in PeopleSoft AMP Diagnostic Utility section in this Appendix Note: To enable DEBUG
logging for metrics/monitoring issues, enable it in psemmetricslogging.properties and to debug
discovery issues enable it in psemdiscoverylogging.properities (found under PSFT Discovery
PLUGIN_ROOT location - AGENT_HOME/plugins/oracle.apps.psft.discovery.plugin_13.3.1.1.0/config/
psemdiscoverylogging.properties)

Enable DEBUG Logging on rootCategory Logger
Set log4j.rootCategory=DEBUG, emagentlogAppender, emagenttrcAppender.

Enable Diagnostic Logging
Set
log4j.category.com.peoplesoft.pt.psem.toolsadmin.common.diagnostics=DEBUG,
emagentdiagAppender.

For more information about diagnostic utility, see PeopleSoft AMP Diagnostics Utility.
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Note: To enable DEBUG logging for metrics and monitoring issues, enable
psemmetricslogging.properties and to debug discovery issues enable psemdiscoverylogging.properities.
Navigate to PSFT Discovery PLUGIN_ROOT location - AGENT_HOME/plugins/
oracle.apps.psft.discovery.plugin_13.3.1.1.0/config/psemdiscoverylogging.properties to modify the files.

RSA Certificate Issues on WebSphere

On some operating systems running WebSphere, root certificates of type RSA are not supported and will
generate errors.

Issue
In some situations where the default signer certificate "root" from WebSphere is an RSA certificate type,
you may see the following exception in the psemagent.log file during the PS Process Monitor discovery:

javax.net.ssl.SSLKeyException: RSA premaster secret error

This indicates that the agent's JDK on the specific operating system does not support RSA certificates.

Solution
To resolve RSA certificate issues:

1. Create a self-signed certificate of type "DSA" using the keytool utility.

For example, the following command creates a custom keystore "pskey" with one self-signed DSA
certificate.

$Agent_Home/jdk/bin/keytool -genkey -alias dsakey -keystore pskey
-keyalg DSA -sigalg SHA1withDSA -storepass password -keypass password
-storetype JKS -dname "cn=localhost"

In the following steps, you will import this DSA certificate into WebSphere, and make it the default
signer certificate for SSL communication.

2. Login to the WebSphere administration console, and select Security, SSL certificate and key
management, Key stores and certificates.

3. Create a new keystore custompskey and import the above DSA certificate from that "pskey" keystore
into this new keystore custompskey.

4. Select SSL certificate and key management, SSL configurations, and create a new SSL configuration
named customSSLConfiguration.

5. Associate the SSL configuration (customSSLConfiguration) with the keystore custompskey and the
DSA key within it.

6. On the SSL certificate and key management screen click the Manage endpoint security configurations
link and replace the "DefaultNodeSSLSettings" with "customSSLConfiguration" settings at the
"node" scope level for both inbound and outbound routes.

7. Verify the certificate by signing on to PeopleSoft.

140  Copyright © 1988, 2018, Oracle and/or its affiliates. All rights reserved.



Chapter 18 Troubleshooting

Sign on through the HTTPS port, and click "View Certificates" from the dialog box WebSphere
presents for the certificate. It should show the DSA certificate imported in the previous steps.

8. Copy the "pskey" keystore with the DSA certificate to a directory under $AgentHome, and set the
pskey.properties file appropriately.

Discovery of Process Monitor target should be successful.

Using the PSEMENV.SH Script for Setting Environment Variables

This section discusses using the psemenv.sh script for setting environment variables instead of
the .profile.

Issue
PeopleSoft Add-on Target Discovery and Target Management processes for UNIX and Linux
environments need relevant environment variables (like PATH, LD_LIBRARY_PATH, TUXDIR,
ORACLE_HOME, TNS_ADMIN etc) to be set on the host machine in the .profile file. Some
environments have customized the .profile file with interactive prompts designed so for interactive
login sessions. However, PeopleSoft Add-on Target Discovery and Target Management processes prefer
the .profile to be non-interactive (as in, not prompting for user inputs).

Solution
If you do not want to modify your .profile to accommodate the PeopleSoft Add-on Target Discovery
and Target Management processes, PeopleTools provides an alternate mechanism to set the required
environment variables. This enables you to set all the required environment variables needed for Target
Discovery and Target Management in a script named psemenv.sh.

To use psemenv.sh:

1. Navigate to the psemconfig.properties file set enableProfile = false:

• AGENT_HOME/plugins/oracle.apps.psft.discovery.plugin_13.3.1.1.0/config/
psemconfig.properties

• AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/config/psemconfig.properties

Note: The enableProfile property in psemconfig.properties file is set to true by default, which means
the PeopleSoft Add-on process will read the environment variables from the .profile file by default.
You need to set the property, enableProfile, explicitly to false if you want the PeopleSoft Add-on
process to read the environment variables from psemenv.sh script instead.

2. Create the script file named psemenv.sh under the User HOME folder or in PS_CFG_HOME folder.

This script file should have all the relevant environment variables necessary for PeopleSoft Add-
on Target Discovery and Target Management. Alternately this script file can be created both under
User HOME and PS_CFG_HOME folders, with some common environment variables set in the
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psemenv.sh script under User HOME folder and some PeopleTools version specific environment
variables set in the psemenv.sh script under PS_CFG_HOME folder.

Mandatory Environment Variables for Discovery

The following environment variables must be included in the .profile or psemenv.sh script:

• ORACLE_HOME=/ds1/home/oracle/Oracle/Database/product/11.2.0/dbhome_1; export
ORACLE_HOME

• TNS_ADMIN=/ds1/home/psoft; export TNS_ADMIN

• TUXDIR=/ds1/home/psoft/bea/tuxedoPS2/tuxedo11gR1; export TUXDIR

• LD_LIBRARY_PATH=$TUXDIR/lib:$ORACLE_HOME/lib:$LD_LIBRARY_PATH; export
LD_LIBRARY_PATH

• SHLIB_PATH=$TUXDIR/lib:$ORACLE_HOME/lib:$SHLIB_PATH; export SHLIB_PATH

• LIBPATH=$TUXDIR/lib:$ORACLE_HOME/lib:$LIBPATH; export LIBPATH

• PATH=$TUXDIR/bin:$ORACLE_HOME/bin:$PATH; export PATH

Process Monitor Target Setup Fails When Using SUDO
Credentials

This section describes how to resolve sudo credential issues when setting up Process Monitor targets.

Issue
The agent-side plug-in element is not able to get the EMHOME environment variable when it's invoked
by a sudo user. This is because the "env_reset" command in the sudo configuration file. The sudo
env_reset command in the sudoers file (/etc/sudoers) resets the environment to a default set of variables.
After the reset, the variable EMHOME gets set to blank. The plug-in fails to discover or setup the Process
Monitor due to the blank value in EMHOME.

Solution
Remove/comment "env_reset" command in the sudoers configuration file ((/etc/sudoers)) for sudo in the
host.

PeopleSoft AMP Diagnostics Utility

With the PSFT AMP diagnostics utility, you can troubleshoot issues to:

• Captures PeopleSoft AMP run-time environment.
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• Capture important PeopleSoft domain configuration files to get an idea about any customization on
them.

• Ascertain diagnostic hints in the diagnostic log files as to what environment related settings might be
missing.

• Capture the output of any PeopleSoft admin commands.

PeopleSoft AMP has a built‐in feature on EM Agent diagnosing issues related to environment set up.
For more information, see E-PSEM: Diagnostic Utility to troubleshoot issues with PeopleSoft Plug-in
for Enterprise Manager (Doc ID 1614036.1) to troubleshoot issues with PeopleSoft AMP for Enterprise
Manager.

1. 2. r 3. Additionally it is recommended to set the generic logging to "debug" mode when enabling
diagnostics because we can correlate actions better between generic log messages and diagnostics log
messages. 

• AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/config/agentLogging.xml

• AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/config/metricLogging.xml

• AGENT_HOME/plugins/oracle.apps.psft.discovery.plugin_13.3.1.1.0/config/discoveryLogging.xml

<Loggers>   
   <Logger name="com.peoplesoft.pt.psem.toolsadmin.common.diagnostics" level="debug⇒
" additivity="false">        
   <AppenderRef ref="emagentdiagAppender"/>         
  <AppenderRef ref="emagenttrcAppender"/>     
 </Logger>     
 <Root level="debug">        
   <AppenderRef ref="emagenttrcAppender"/>         
  <AppenderRef ref="emagentlogAppender"/>     
 </Root>
</Loggers>

Note: It would be better to turn-on diagnostics only when needed as it generates too many log messages
into diagnostic log files. Before starting to diagnose an issue, it is a good practice to clean up all old logs
from under "$HOME/psft/pt/emplugin/log" and "$HOME/psft/pt/emplugin/log/ diag" locations. To search
for Diagnostic Hints thrown by PeopleSoft AMP into the diagnostic log files - psemdiscoverydiag.trc,
psemagentdiag.trc & psemmetricsdiag.trc search for the string pattern - "XXX DIAGNOSTIC HINT
XXX" Note: Enabling Diagnostic utility creates a "diag" folder under the Agent logging location
- $HOME/psft/pt/emplugin/log/diag - only upon first discovery of a target. However if you are
investigating diagnostics for Monitoring or Target Management issue, then you can manually create this
"diag" folder - $HOME/psft/pt/emplugin/log/diag - to avoid seeing exceptions related to this folder not
being found.

Enabling Diagnostic Logging
To enable diagnostics utility You must set the following:

1. Navigate to, AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/config/
psemconfig.properties and AGENT_HOME/plugins/oracle.apps.psft.discovery.plugin_13.3.1.1.0/
config/psemconfig.properties  to set enableDiagnostics=true.

2. Navigate to the following files:

• AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/config/agentLogging.xml
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• AGENT_HOME/plugins/oracle.apps.psft.agent.plugin_13.3.1.1.0/config/metricLogging.xml

• AGENT_HOME/plugins/oracle.apps.psft.discovery.plugin_13.3.1.1.0/config/
discoveryLogging.xml

Switch the level attribute to debug:

<Loggers>     
 <Logger name="com.peoplesoft.pt.psem.toolsadmin.common.diagnostics" level="debug" ⇒
additivity="false">    
       <AppenderRef ref="emagentdiagAppender"/>      
     <AppenderRef ref="emagenttrcAppender"/>   
   </Logger>    
  <Root level="debug">       
    <AppenderRef ref="emagenttrcAppender"/>      
     <AppenderRef ref="emagentlogAppender"/>
     </Root>
</Loggers>

Creating WebLogic PIA Domain Issues on the AIX platform

Issues are encountered on while creating Weblogic PIA domain on AIX platform.

Issue
Creating PIA domain on WebLogic fails because hostname and chmod could not run on the AIX platform.

Solution
To resolve this issue, set the following PATH in the PsMpPIAInstaller Setup script:

PS_HOME/setup/PsMpPIAInstall/setup.sh
main()
{
PATH=/jre/prod/1.7.0/bin:/bin:/sbin:/usr/sbin:/usr/bin:/usr/local/bin:/usr/etc:/usr⇒
/ccs/bin:/usr/bin/X11:/usr/ucb:.:/tuxedo/prod/12.1.1.0‐j12‐
64bit/bin:/cobol/prod/svrexp‐5.1_wp6‐64bit/bin:/products/oracle/11.2.0.2.0/bin; exp⇒
ort PATH

Replicate PIA Issue

The replicate PIA may fail due to redundancy in classpath.

Solution
1. Backup PLUGIN_ROOT/scripts/psem/PSEM_MASTER.pl.

2. Open PLUGIN_ROOT/scripts/psem/PSEM_Master.pl and remove the following line:

$ENV{'EMDROOT'} . $sep . 'lib' . $sep . 'xmlparserv2.jar' . $jarsep.
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3. Restore the CLASSPATH to include xmlparserv2.jar in the PSEM_Master.pl script after the
replication of PIA.

PIA Target Status Issues on Solaris and Unix Platforms

The PIA target status displays incorrect message.

Issue
Incorrect display of the PIA target status on EM console due wrong pointing of - /bin/sh to a wrong
Unix shell.

Solutions
Repoint the /bin/sh link to /bin/bash (Bourne Shell). It is commonly known that Bourne Shell
fixes issues such as this on UNIX platform.
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